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Chapter I. Getting started
This getting started guide provides a brief introduction to the Apache Directory Studio Browser.

1. Download and installation
The latest version of Apache Directory Studio can be downloaded from the Apache Directory
Studio Downloads page, at this address :  https://directory.apache.org/studio/downloads.html  [https://
directory.apache.org/studio/downloads.html] .

The download page also includes the installation instructions.

2. Open LDAP perspective
To use the Apache Directory Studio Browser plug-in open the LDAP perspective. Therefore go to
Window → Open Perspective → Other...  and select the LDAP perspective.

For more information about the LDAP perspective see LDAP perspective

3. Create connection
The bottom left corner shows all of the LDAP connections. As can be seen, the view is empty, meaning
a connection still needs to be specified.

To create a new connection click the  New Connection button.

In the wizard's first page enter a connection name as well as the hostname and the port of the LDAP server.
To check the connection parameter you entered you may click to Check Network Parameter. Click Next
when done.

https://directory.apache.org/studio/downloads.html
https://directory.apache.org/studio/downloads.html
https://directory.apache.org/studio/downloads.html
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Here is a list of common directory servers and the ports they use by default:

Directory Server Default Port

Apache Directory Server 10389

OpenDS 1389

OpenLDAP, Fedora, Sun, Active Directory 389

In the wizard's second page select the authentication method. If you choose the simple bind method also
enter your bind DN or user and bind password. To check the authentication parameter you entered you
may click to Check Authentication. Click Finish when done.

Here is a list of common directory servers and the administrator's bind DN and password they use by
default:

Directory Server Default Bind DN Default Bind
Password

Apache Directory Server uid=admin,ou=systemsecret
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Directory Server Default Bind DN Default Bind
Password

OpenDS, Sun, Fedora cn=Directory
Manager

specified at setup

OpenLDAP specified at setup,
see slapd.conf

specified at setup,
see slapd.conf

Observe that the Connections view now shows the created connection.

For more information see Connections view

4. Browse the directory
The LDAP Browser view is on the top left. The category  DIT shows the hierarchical content of the
directory. You may expand and collapse the tree.

When selecting an entry its attributes and values will be displayed in an Entry editor.

For more information see LDAP Browser view and Entry editors.

5. Search the directory
For a basic search you could use the Quick Search.

For a more advanced serach you may use the search function.

1. In the toolbar click the  Search button.

2. If it is not already selected, select the  LDAP Search tab.
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In the search dialog type in a search name. Select a connection to search on and the search base DN.
Specify a valid LDAP filter and the returning attributes as comma separated list, hit Ctrl-Space to get
content assistance. Additionally you may choose scope, limits, alias and referral options.

3. Press the Search button.

4. The category  Searches in the LDAP Browser shows the searches. You may expand the search to
see all search result enties.

When selecting a search the search results and returning attributes will be displayed in the Search
Result editor.

When selecting a search result entry its attributes and values will be displayed in the Entry editor.
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For more information see LDAP Browser view and Search Result editor.
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Chapter II. Tools

1. LDAP perspective
The Apache Directory Studio Browser plug-in provides a LDAP perspective. It is designed for working
with an LDAP directory (browse, edit, search) as well as for editing LDIF files. The views and edtiors
are arranged as follows:

The bottom left view shows all the Connections. It is used to create, edit, delete, open and close
connections. When selecting a single connection the LDAP Browser shows the content of the selected
connection.

The LDAP Browser view is on the top left. It shows the directory information tree (DIT), the persistent
searches and bookmarks of the selected connection. With the LDAP Browser you are able to navigate
and modify the DIT, perform searches and manage bookmarks. When selecting a single entry the Entry
editor shows its attributes and values. When selecting a single search the Search Result editor shows the
search results.

The editor area in the top middle. The following LDAP specific editors are available:

• The Entry editor displays the attributes and values of the currently selected entry. Further it is possilbe
to add, edit and delete attributes

• The Search Result editor shows the result of the currently selected search in a table. Further it is
possible to edit the search result in a spreadsheet-like manner.

• With the Schema Browser you could browse the schema with its object class and attribute definitions.
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• The LDIF editor is a rich editor to create LDIF files. It provides well-known Eclipse features like syntax
highlighting and content assistance

The Outline view on the top right displays the structure of the entry currently opended in the entry editor
or the structured outline of the currently opened LDIF file.

The bottom centered view displays all Modifications made on the currently selected connection as LDIF
change records and all Searches performed on the on the currently selected connection as LDIF records.

The bottom right Progress view displays long-running operations like connecting to the directory or
import/export operations.

2. Views and editors
2.1. Connections view

The Connections view shows all the LDAP connections that you have added. Here is an example screenshot
of the Connection view:

Organize Connections

It is possible to organize connections in folders and sub-folders. Use drag-and-drop to re-organize
connections and folders.

You could copy and paste the connection parameters as LDAP URL to/from the clipboard. This makes it
very easy to share connection parameters with other users.

Icons

The following icons can appear in the Connections view:

Icon Description

Connection is opened.

Connection is closed.

Secure Connection is opened.

Secure Connection is closed.

Connection folder

Toolbar
Icon Action Description

New Connection... Starts the New Connection wizard
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Icon Action Description

Open Connection Opens the selected connection(s)

Close Connection Closes the selected connection(s)

Expand All Expands all connection folders

Collapse All Collapses all connection folders

Context Menu

Icon Action Description Shortcut

New Connection... Starts the New Connection wizard

New Connection
Folder...

Opens a dialog to create a new connection
folder.

Open Connection Opens the selected connection(s)

Close Connection Closes the selected connection(s)

Open Schema
Browser

Opens the Schema Browser and shows the
schema of the selected connection

Copy Connection Copies the selected connection(s) as LDAP
URL(s) to the clipboard. To duplicate an
existing connection please combine copy and
paste.

Ctrl-C or Ctrl-Insert

Paste Connection Pastes the copied connection(s) or LDAP
URL(s) from clipboard. Only enabled if there
are connections or LDAP URLs in clipboard.

Ctrl-V or Shift-
Insert

Delete Connection Deletes the selected connections(s). Only
enabled if the selected connections are closed.

Delete

 Select All Selects all connections. Ctrl-A

 Rename Connection... Opens a dialog to rename the selected
connection.

F2

 Rename Connection
Folder...

Opens a dialog to rename the selected
connection folder.

F2

Import → LDIF
Import...

Starts the LDIF Import wizard.

Import → DSML
Import...

Starts the DSML Import wizard.

Import → Import
Connections...

Starts the Import Connection wizard.

Export → LDIF
Export...

Starts the LDIF Export wizard.

Export → DSML
Export...

Starts the DSML Export wizard.

Export → CSV
Export...

Starts the CSV Export wizard.

Export → Excel
Export...

Starts the Excel Export wizard.
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Icon Action Description Shortcut

Export → ODF
Export...

Starts the ODF Export wizard.

Export → Export
Connections...

Starts the Export Connections wizard.

 Properties Opens the connection properties dialog. Alt-Enter

2.2. LDAP Browser view
The LDAP Browser shows the directory information tree (DIT), the persistent searches and bookmarks of
the selected connection in three separate categories. It allows you to explore the directory content.

2.2.1. Overview

This section describes general aspects of the LDAP Browser view.

Example screenshot

Icons

The following icons can appear in the LDAP Browser view:

Icon Description

The top-level category containing the directory information tree.

    Entry, the icon depends on its object classes.

 Alias or referral entry.

The schema entry.

The root DSE entry.

A container for folded entries.

The top-level category containing persistent searches.

A search.
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Icon Description

The top-level category containing bookmarks.

A Bookmark.

Toolbar

The toolbar contains the following items:

Icon Action Description

Up Selects the parent node of the currently selected node.

Refresh Refreshes the selected objects

Collapse All Collapses the whole tree, only the three top-level categories
remain visible.

Link With Editor Links the editor with the current selection and the selection
with the current editor.

Drop Down Menu

The drop down menu contains the following items:

• Sorting...: Opens the  Sort Dialog .

• Show Quick Search: Shows/Hides the .  Quick Search .

• Show DIT: Shows the DIT category.

• Show Searches: Shows the Searches category.

• Show Bookmarks: Shows the Bookmarks category.

• Show Directory Metadata: Shows the directory metadata entries (e.g. the root DSE or the schema entry)
inside the DIT category.

• Preferences...: Opens the  LDAP Browser preferences  dialog.

Quick Search

The Quick Search allows searching the DIT with specifying only a single search attribute and value.
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To use the quick search select an entry in the DIT first. It is used as search base.

In the left input field you could type in the search attribute. There is an auto-completion of known attributes.
You could also select a recently used attribute from the drop-down box.

In the next drop-down box you could select the search operations.

In the right input field you could type in the search value. You could use '*' as wildcard. You could also
select a recently used value from the drop-down box.

The  icon toggles the search scope: To search only the direct descendants of the selected entry uncheck
the button. Check the button to search the whole subtree.

When pressing the  button the search is executed. You could also press Enter in one of the input fields
to execute the search.

The search result is presented directly under the selected entry using a  Quick Search icon.

Sort dialog

With the sort dialog you can set the sorting behaviour of the LDAP Browser view.

Field Description Default

Leaf entries first If enabled, entries without children are grouped
before the entries with children.

on

Container entries first If enabled, entries with children are grouped before
the entries without children.

on
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Field Description Default

Mixed If enabled, entries with and without children are not
group before each other.

on

Meta entries last If enabled, meta entries (e.g. root DSE or schema
entry) are grouped after all other entries.

on

Sort by Sort criteria and order of entries in DIT and search
results. Select either 'RDN' or 'RDN Value' from
the drop-down list as sort critera and select the sort
order. Or select 'No sorting' to disable sorting.

RDN Value and
Ascending

Sort limit If there are more than the specified number of
children or search results they won't be sorted.
Hint: For performance reasons the maximum value
should be 10000!

10000

2.2.2. DIT category

This section describes the DIT category in the LDAP Browser view.

Navigation

In the DIT category the directory information tree of the LDAP directory is displayed in its natural
hierarchical structure. The first hierachy level contains the base entries, the Root DSE and the schema
entry. When expanding an entry its direct children are fetched from directory. To expand and collapse an
entry you could also double-click.

Children detection

While browsing the directory the LDAP Browser tries to find out if a fetched entry has children. Entries
without children couldn't be expanded. This behaviour could be changed in the  LDAP Browser preferences
.

Labels

By default the RDN of the entries is used as label and the length of the label is limited to 50 characters.
This behaviour could be changed in the  LDAP Browser preferences  . For the Base entries always the
whole DN is used as label.

If an entry has child entries the number of children is appended in parentheses to the label. If the directory
server returned a partial result (e.g. because of count or time limits) a plus (+) character is appended to the
number of children to indicate that there are more child entries. Note: The limit parameters are inherited
from connection properties.

Icons

The following icons are used to distinguish entry types:

Icon Description

Entry with object class person, inetOrgPerson, posixAccount, user

Entry with object class groupOfNames, groupOfUniqueNames, posixGroup,
group
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Icon Description

Entry with object class organization, organizationalUnit, container

Entry with object class domain, domainComponent, country, locality

Entry with object class alias

Entry with object class referral

The schema entry.

The root DSE entry.

All other entries

Alias and referral entries

To manage alias entries you have the following options:

• Disable the options "Finding Base DN" and "Search" in the "Aliases Dereferencing" group of the
Connection properties  . This setting will display  alias entries in the tree.

• If you know that an entry contains alias child entriy you could select Fetch > Fetch Aliases  from the
browser's context menu.

To manage referral entries you have the following options

• Enable the option "Use ManageDsaIT control" in the "Controls" group of the  Connection properties  .
This setting will display  referral entries in the tree.

• If you know that an entry contains referrals child entriy you could select Fetch > Fetch Referrals  from
the browser's context menu.

Folding

By default the entries of large branches are folded into virtual folders  each with 100 entries. This may
help to keep the displayed tree smaller. This behaviour could be changed in the  LDAP Browser preferences
.

Filter Children

With the  Filter Children action you can define a filter to select entries returned by the server for your
needs. You could recognise a filtered entry by its modified icon and label.

2.2.3. Searches category

This section describes the Searches category in the LDAP Browser view.

New Search

To perform a new search please choose one of the following methods:
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• Select a search or entry and choose  New Search... from the context menu. The selected search or
entry is used to preset search parameters.

• Use the Workbench  Search action.

Please see Search dialog how to define the search parameters.

Navigation

In the Searches category the searches and belonging search results are displayed. The first hierachy level
contains the Searches, the second hierarchie level shows the search result entries. To expand and collapse
a search the double-click could be used.

With the  Open Search Result in DIT action the search result entry could be located in the DIT.

Unperfomed Searches

An unperfomed search could be identified by the gray search icon  and the absent number in parentheses
at the end of the search name label. To perfom the search expand it or press the refresh button.

Perfomed Searches

A perfomed search could be identified by the yellow search icon  If a search is performed the number of
search results is appended in parentheses to the search name label. If the directory server returned a partial
result (e.g. because of count or time limits) a plus (+) character is appended to the number of search results
to indicate that there are more results. To perfom the search again press the refresh button.

Search Results

By default the DN of the search results is used as label and the length of the label is limited to 50 characters.
This behaviour could be changed in the  LDAP Browser preferences  .

The icons of the search results depends on the RDN type, see  DIT category . Additional the search results
have a small overlay image 

Folding

By default large search results folded into virtual folders  each with 100 entries. This may help to keep
the displayed tree smaller. This behaviour could be changed in the  LDAP Browser preferences  .

Batch Operation

With the  New Batch Operation... action you can execute a modify operation to all search results.

2.2.4. Bookmarks category

This section describes the Bookmark category in the LDAP Browser view.
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Bookmarks could be used to quickly access frequently used entries.

New Bookmark

To create a new bookmark select an entry or search result and choose  New Bookmark... from the
context menu.

Navigation

With the  Open Bookmark in DIT action the bookmark entry could be located in the DIT.

2.2.5. Context Menu

This section describes the context menu of the LDAP Browser view.

New > New Entry...

• Icon: 

• Description: Opens the  New Entry wizard  . The selected entry is used as template or to preset the
parent entry.

• Enabled: If one entry, search result or bookmark is selected.

New > New Context Entry...

• Icon: 

• Description: Opens the  New Context Entry wizard  .

• Enabled: If one entry, search result or bookmark is selected.

New > New Search...

• Icon: 

• Description: Opens the  Search dialog  . The selected search or entry is used to preset the search
parameters.

• Enabled: If one search, entry, search result or bookmark is selected.

• Shortcut: Ctrl-H

New > New Bookmark...

• Icon: 

• Description: Opens the bookmark dialog. The selected entry is used to preset the new bookmarks name
and DN.

• Enabled: If one entry, search result or bookmark is selected.

New > New Batch Operation...

• Icon: 
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• Description: Opens the  Batch Operation wizard  . If one or multiple entries are selected they are used
as operation objects. If a search is selected its search results are used as operation objects.

• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are selected.

Open Entry

• Description: Opens the selected entry in the default entry editor.

• Enabled: If one entry, search result or bookmark is selected.

Open With >

Opens the selected entry in a custom Entry editor. The follwing editor types are available:

• Table Entry Editor (single-tab)

• Icon: 

• Description: Displays attributes and values in a table grid. Single-tab means that only one instance of
the editor is used, all entries are opened in the same editor tab. This is the traditional Entry editor.

• Table Entry Editor (multi-tab)

• Icon: 

• Description: Displays attributes and values in a table grid. Multi-tab means that each entry is opened
in its own editor tab.

• LDIF Entry Editor (multi-tab)

• Icon: 

• Description: Displays attributes and values in LDIF format. Multi-tab means that each entry is opened
in its own editor tab.

• LDIF Entry Editor (single-tab)

• Icon: 

• Description: Displays attributes and values in LDIF format. Single-tab means that only one instance
of the editor is used, all entries are opened in the same editor tab.

Open Search Result in DIT / Open Bookmark in DIT

• Icon:  / 

• Description: Opens the selected search result or bookmark in DIT.

• Enabled: If one search result or bookmark is selected.

• Shortcut: F3

Up

• Icon: 
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• Description: Opens the parent node of the selected node.

• Enabled: If a node with a parent is selected.

• Shortcut: F4

Copy Entries / DNs

• Icon: 

• Description: Copies the selected entries and DNs to the system clipboard. The entries are copied in an
internal format and could be pasted inside the LDAP Browser view. The DNs are copied as text and
could be pasted even outside of Studio.

• Enabled: If one or multiple entries, search results or bookmarks are selected.

• Shortcut: Ctrl-C or Ctrl-Insert

Paste Entries

• Icon: 

• Description: Pastes the previously copied entries as children into the selected entry. If the copied entries
have children you are asked for the copy depth.

The new entries will receive the same RDNs and attributes as the copied entries. If there is already an
entry with the same RDN you are asked how to proceed.

• Enabled: If one entry is selected and the system clipboard contains entries.

• Shortcut: Ctrl-V or Shift-Insert

Delete

• Icon: 

• Description: Deletes the selected elements, the real action depends on the selected elements type:

• Entries or Search Results: The entries and its children are deleted physically from directory. It is not
possible to delete base entries or the root DSE.

• Searches: The selected searches are removed from the view. No entries from directory are deleted.
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• Bookmarks: The selected bookmarks are removed from the view. No entries from directory are
deleted.

• Enabled: If one or multiple searches, entries, search results or bookmarks are selected.

• Shortcut: Delete

Move Entries...

• Description: Moves the selected entries to another parent. The  Move Entries dialog  is opened to select
the new parent DN.

• Enabled: If one or multiple entries or search results are selected.

Rename...

• Description: Renames the selected element, the real action depends on the selected element type:

• Entry or Search Result: Renames the selected entry in directory. The  Rename Entry dialog  is opened
to specify a new RDN.

• Search: Renames the selected search.

• Bookmark: Renames the selected bookmark.

• Enabled: If one search, entry, search results or bookmark is selected.

• Shortcut: F2

Advanced > Copy DN

• Icon: 

• Description: Copies the distinguished name of the selected entry (e.g. cn=John
Fowler,ou=People,o=JNDITutorial)

• Enabled: If one entry, search result or bookmark is selected.

Advanced > Copy URL

• Icon: 

• Description: Copies the URL of the selected entry (e.g. ldap://localhost:389/cn=John
Fowler,ou=People,o=JNDITutorial)

• Enabled: If one entry, search result or bookmark is selected.

Advanced > Copy Entry as LDIF

Copies the selected entries in LDIF content format. There are four options:

• DN only

• Icon: 

• Description: Copies the distinguished names of the selected entries in LDIF format. If a search is
selected the distinguished names of all search results are copied.
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• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are
selected.

• returning attributes only

• Icon: 

• Description: Copies all returning attributes of the selected search result entries in LDIF format. If a
search is selected the returning attributes of all search results are copied.

• Enabled: If one search is selected or if one or multiple search results are selected.

• all user attributes

• Icon: 

• Description: Copies all user attributes of the selected entries in LDIF format. If a search is selected
the user attributes of all search results are copied.

• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are
selected.

• include operational attributes

• Icon: 

• Description: Copies all user attributes and operational attributes of the selected entries in LDIF format.
If a search is selected the attributes of all search results are copied.

• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are
selected.

Advanced > Copy Entry as CSV

Copies the selected entries in CSV format. By default the tabulator is used as attribute delimiter, a pipe is
used as value delimiter and each attribute is wrapped by double-quotes, these settings could be changed
in  Text Formats preferences  . There are four options:

• DN only

• Icon: 

• Description: Copies the distinguished names of the selected entries in CSV format. If a search is
selected the distinguished names of all search results are copied.

• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are
selected.

• returning attributes only

• Icon: 

• Description: Copies all returning attributes of the selected search result entries in CSV format. If a
search is selected the returning attributes of all search results are copied.

• Enabled: If one search is selected or if one or multiple search results are selected.
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• all user attributes

• Icon: 

• Description: Copies all user attributes of the selected entries in CSV format. If a search is selected
the user attributes of all search results are copied.

• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are
selected.

• include operational attributes

• Icon: 

• Description: Copies all user attributes and operational attributes of the selected entries in CSV format.
If a search is selected the attributes of all search results are copied.

• Enabled: If one search is selected or if one or multiple entries, search results or bookmarks are
selected.

Advanced > Delete All

• Icon: 

• Description: The action depends on the selected element type:

• Entry: The children entries of the selected entry are deleted physically from directory. It is not possible
to delete base entries or the root DSE.

• Search or 'Searches' category: All the searches are removed from the view. No entries from directory
are deleted.

• Bookmark or 'Bookmarks' category: All the bookmarks are removed from the view. No entries from
directory are deleted.

• Enabled: If an entry, search, bookmark, the 'Searches' or 'Bookmarks' category is selected.

Filter Children...

• Icon: 

• Description: Opens the Filter Children dialog to specify a children filter for the selected entry.

• Enabled: If one entry in DIT category is selected.

Remove Children Filter

• Icon: 

• Description: Removes the children filter.

• Enabled: If one entry in DIT category is selected and a children filter is set.

Import > LDIF Import...

• Icon: 
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• Description: Starts the  LDIF Import wizard  .

Import > DSML Import...

• Icon: 

• Description: Starts the  DSML Import wizard  .

Export > LDIF Export...

• Icon: 

• Description: Starts the  LDIF Export wizard  .

Export > DSML Export...

• Icon: 

• Description: Starts the  DSML Export wizard  .

Export > CSV Export...

• Icon: 

• Description: Starts the  CSV Export wizard  .

Export > Excel Export...

• Icon: 

• Description: Starts the  Excel Export wizard  .

Export > ODF Export...

• Icon: 

• Description: Starts the  ODF Export wizard  .

Refresh

• Icon: 

• Description: Refreshes the selected elements. If entries, search results or bookmarks are selected their
attributes and children are refreshed. If searches are selected this searches are performed

• Enabled: If one or multiple searches, entries, search results or bookmarks are selected.

• Shortcut: F5

Fetch -> Fetch Operational Attributes

• Description: Enables/disables fetching of operational attributes. If the server supports the 'All
Operational Attributes' feature the operation attributes are requested using a '+', otherwise all available
operational attributes available in the schema are requested.
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• Enabled: If one or multiple entries, search results or bookmarks are selected.

• Note: This menu item is not available if "Fetch operational attributes while browsing" in the connection
properties is enabled because in that case operational attributes are always loaded.

Fetch -> Fetch Aliases

• Description: Enables/disables fetching of alias entries. If enabled an additional search request with alias
dereferncing mode 'never' is necessary when loading the children of an entry.

• Enabled: If one or multiple entries are selected.

• Note: This menu item is not available if no alias dereferencing is enabled in the connection properties
because in that case alias entries are always visible.

Fetch -> Fetch Referrals

• Description: Enables/disables fetching of referral entries. If enabled an additional search request with
ManageDsaIT controls is necessary when loading the children of an entry.

• Enabled: If one or multiple entries are selected.

• Note: This menu item is not available if "Use ManageDsaIT control while browsing" is enabled in the
connection properties because in that case referral entries are always visible.

Fetch -> Fetch Subentries

• Description: Enables/disables fetching of subentries. If enabled an additional search request with
Subentries controls is necessary when loading the children of an entry.

• Enabled: If one or multiple entries are selected.

• Note: This menu item is not available if "Fetch subentries while browsing" is enabled in the connection
properties because in that case subentries are always fetched.

Properties

• Description: Opens the  entry properties  ,  search properties  or  bookmark properties  dialog.

• Enabled: If one search, entry, search result or bookmark is selected.

• Shortcut: Alt-Enter

2.3. Entry editors
Entry editors are used to view and edit the attributes and values of an entry.

Editor Types

There are two editor types available.

• Table Entry editor: Displays the entry's attributes and values in a table grid.

• LDIF Entry editor: Displays the entry's attributes and values in LDIF format.
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By default the single-tab Table Entry editor is used, you could change that setting in the Entry Editor
preferences.

Single-Tab vs. Multi-Tab

Each editor type can be used in single-tab or multi-tab mode.

• Single-tab means that only one instance of the editor is used, all entries are opened in the same editor tab.

• Multi-tab means that each entry is opened in its own editor tab.

Open Mode

With the open mode you could define how an entry should be opened while navigating through the DIT
in the LDAP Browser view.

• Traditional: Editors open on single-click, using arrow keys triggers the opening of a new editor.

• Application-wide open mode + double-click: Editors open on double-click, using arrow keys requires
an explicit enter to open the entry in an editor.

• Application-wide open mode + single-click: Editors open on single-click, arrow key and hover
behaviour could be configured.

By default the traditional open mode is used, you could change that setting in the Entry Editor preferences.

2.3.1. Table Entry Editor Overview

This section describes general aspects of the Table Entry editor.

Example screenshot
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Layout

The Entry editor has a two-column layout. The left column contains the attribute descriptions (names), the
right column contains the attribute values. Each line represents a name-value pair.

The Entry editor has its own toolbar. The left part displays the distinguished name of the current entry.
The right part contains the toolbar icons and menu.

Colors and Fonts

To distinguish the different attribute classes the Entry editor uses different fonts. By default the following
colors and fonts are used:

Attribute class Default
font

Default
color

Example

objectClass attribute bold and
italic

black

Must attributes bold black

May attributes normal black

Operational attributes italic black

These colors and fonts could be changed in the  Colors and Fonts preferences  .

Toolbar

The toolbar contains the following items:

Icon Action Description Shortcut

New Value Adds a new value to the selected attribute and starts
the edit mode.

Ctrl-+

New Attribute... Opens the  New Attribute wizard  . When finishing
the wizard a new attribute is created and the edit
mode is started to enter a value.

Shift-Ctrl-+

Delete Deletes the selected values. Delete

Delete Attributes Deletes all values of the selected attributes.
Applicable to multi-valued attributes, if you want to
delete the complete attribute just select one value
use this action.

Reload Attributes Reloads the attributes of the current entry. F5

Expand All Expands all folded attributes.

Collapse All Collapses all folded attributes.

Show Quick Filter Shows/Hides the  Quick Filter  . Ctrl-F

Drop Down Menu

The drop down menu contains the following items:

• Sorting...: Opens the  Sort Dialog  to set default sorting.
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• Show Decorated Values: If checked decorated values are displayed, this means some additional
information is displayed:

• Images: Image format, width, height, and size.

• Binary data: Data size.

• Passwords: Used hash method.

• Timestamps: Locale dependent date and time format.
If unchecked the raw values (as stored in directory) are displayed.

• Save Automatically: If checked, each modifcation (add attribute, edit value, delete attribute) is saved
automatically and a modify request is sent to the server. If unchecked the editor becomes dirty (an
asterisk '*' appears in the editor tab) if the entry is modified. Multiple modifications could be applied to
the entry. The editor must be saved explicitely using Ctrl+S.

• Preferences...: Opens the  Entry editor preferences  dialog.

2.3.2. Table Entry Editor Features

This section describes the features of the Table Entry editor.

Sorting

You could sort the displayed attributes by attribute description or value by clicking to the column header.
The current sort criteria and direction is indicated by an arrow. The default sorting behaviour could be
changed in the  Sort Dialog  (  Toolbar menu ->  Sorting  ):

Sort dialog

The default sorting behaviour of the entry editor could be changed in this dialog.

Field Description Default

ObjectClass and must
attributes first

If enabled, objectClass and must attributes are
grouped at the top.

on

Operational attributes
last

If enabled, operational attributes (e.g.
createTimestamp and modifyTimestamp) are
grouped at the bottom.

on

Sort by Default sort criteria and order of attribute and
values. Select either 'Attribute Description' or

Attribute Description
and Ascending
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Field Description Default

'Value' from the drop-down list as sort critera and
select the sort order. Or select 'No sorting' to disable
default sorting.

Quick Filter

If an entry has many attributes and values it is difficult to find a specific attribute. The Quick Filter provides
a client-side filter. To show/hide the Quick Filter toggle the  button or press Ctrl-F . Enter (even parts
of) attribute descriptions or values into the input fields, only matching attributes keep displayed. When
hiding the filter is removed.

Visible attributes

By default all user attributes of an entry are fetched and displayed in the Entry editor. You could define
to request operational attributes for each entry for the whole connection, see  Connection properties
for details. Another way is to request operational attributes for the selected entry only, choose Fetch
Operational Attributes from the context menu.

Folding

By default attributes with more than 10 values are folded. The attribute is displayed as single line containing
the number of values

Expand the attribute to make the values visible (double-click works also). To expand/collapse all folded
attributes use the  Collapse All and  Expand All and buttons from toolbar.

You could change this setting in  Entry editor preferences .

Locate DN in DIT

If a value contains a distinguished name the  Locate DN in DIT action can be used to locate and open
the entry in the DIT.

Query by example

When selecting attributes these attribute-value-pairs are used to build a search filter, this feature could be
used for "query by example".

• Select example attributes and choose New Search... from context menu. Watch the search filter in the
search dialog.
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• Select example attributes and choose  Advanced -> Copy [NOT|AND|OR] Search Filter  from context
menu. This copies the search filter to system clipboard.

When building a filter necessary value encoding is supported (*->\2a, (->\28, )->29, \->\5c, NUL->\00).

Edit Attributes and Values

It is possible to add, edit or delete attributes and values of an entry in the Entry editor.

To enter the edit mode using the default value editor select a value and press Enter or F7 or double-click
the value. If the attribute is a simple string (like givenName or telephoneNumber) the value could be edited
in-place, otherwise a specific value editor dialog is opened. To use a specific value editor choose one from
Context Menu -> Edit Value With .

To finish editing press Enter or click to another value or click the OK button in a value editor dialog. To
cancel editing press ESC or click the Cancel button in a value editor dialog.

Edit Entry Offline and Save Automatically

Sometimes you may want to make multiple modifications on an entry and to send these modifications as
one request to the server. This is necessary e.g. when adding an additional object class which requires
addional attributes. There are two ways to accomplish this.

One way is to toggle the "save modifications automatically" setting. This could be done from the editor's
drop-down menu or in the Table Entry Editor preferences. This mode could be set independently for the
single-tab and the multi-tab editor. For the single-tab editor it is enabled by default, for the multi-tab editor
it is disabled by default. If disabled the editor becomes dirty (an asterisk '*' appears in the editor tab) if the
entry is modified. The editor must be saved explicitely using Ctrl+S.

Another way is to use the Editor Entry Wizard. To start the wizard press F8 or choose Edit Entry... from
the context menu.

2.3.3. Table Entry Editor Context Menu

This section describes the context menu of the Table Entry editor.

New Attribute...

• Opens the  New Attribute wizard  . When finishing the wizard a new attribute is created and the edit
mode is started to enter a value.

• Icon: 

• Shortcut: Shift-Ctrl-+

New Value

• Adds a new value to the selected attribute and starts the edit mode.

• Icon: 

• Enabled: If one attribute or value is selected.

• Shortcut: Ctrl-+
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New Search...

• Opens the  Search dialog  . The selected attributes and values are used to build the search filter (Query
by example).

• Icon: 

• Enabled: If attributes or values are selected.

• Shortcut: Ctrl-H

New Batch Operation...

• Opens the  Batch Operation wizard  . If one or multiple DN values are selected these DNs are used as
operation objects. Otherwise the selected attributes and values are used to build the search filter (Query
by example).

• Icon: 

• Enabled: If attributes or values are selected.

Locate DN in DIT

• Locates the entry of the selected DN in DIT.

• Icon: 

• Enabled: If one value is selected and this value is a distinguished name.

• Shortcut: F3

Open Schema Browser -> Object Class Definition

• Opens the  Object Class page  in  Schema Browser  and selects the object class definition of the currently
selected objectClass value.

• Icon: 

• Enabled: If one objectClass value is selected and the schema contains this object class.

Open Schema Browser -> Attribute Type Definition

• Opens the  Attribute Type page  in  Schema Browser  and selects the attribute type definiton of the
currently selected attribute.

• Icon: 

• Enabled: If one attribute or value is selected and the schema contains this attribute type.

Open Schema Browser -> Equality Matching Rule Definition

• Opens the  Matching Rule page  in  Schema Browser  and selects the equality matching rule definiton
of the currently selected attribute.

• Icon: 



Tools

29

• Enabled: If one attribute or value is selected, the attribute provides an equality matching rule and the
schema contains this matching rule.

Open Schema Browser -> Substring Matching Rule Definition

• Opens the  Matching Rule page  in  Schema Browser  and selects the substring matching rule definiton
of the currently selected attribute.

• Icon: 

• Enabled: If one attribute or value is selected, the attribute provides a substring matching rule and the
schema contains this matching rule.

Open Schema Browser -> Ordering Matching Rule Definition

• Opens the  Matching Rule page  in  Schema Browser  and selects the ordering matching rule definiton
of the currently selected attribute.

• Icon: 

• Enabled: If one attribute or value is selected, the attribute provides an ordering matching rule and the
schema contains this matching rule.

Open Schema Browser -> Syntax Definition

• Opens the  Syntax page  in  Schema Browser  and selects the syntax definiton of the currently selected
attribute.

• Icon: 

• Enabled: If one attribute or value is selected, the attribute provides an syntax and the schema contains
this syntax.

Copy Values

• Copies the selected values. The values are copied to clipboard in an internal format so they could be
pasted to another entry even in the search result editor. Additional the displayed values are copied to
the system clipboard as string so they could be pasted in other applications. New-line is used as value
separator.

• Icon: 

• Shortcut: Ctrl-C or Ctrl-Insert

Paste Values

• Pasted the previously copied values to the current entry. Each value is copied separately, when an error
occurs while adding the value the paste operation will continue with the next value.

• Icon: 

• Enabled: If the system clipboard contains values.

• Shortcut: Ctrl-V or Shift-Insert
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Delete

• Deletes the selected attributes and values.

• Icon: 

• Enabled: If attributes and values are selected.

• Shortcut: Delete

Select All

• Selects all attributes and values.

• Shortcut: Ctrl-A

Advanced > Copy DN

• Copies the distinguished name of the current entry (e.g. cn=John Fowler,ou=People,o=JNDITutorial)

• Icon: 

Advanced > Copy URL

• Copies the URL of the current entry (e.g. ldap://localhost:389/cn=John
Fowler,ou=People,o=JNDITutorial)

• Icon: 

Advanced > Copy Attribute Descriptions

• Copies the attribute descriptions of the selected attributes and values as string to the system clipboard.

• Icon: 

Advanced > Copy Display Values

• Copies the values as displayed in the entry editor, either decorated or not.

• Icon: 

Advanced > Copy Values (UTF-8)

• Copies the selected values UTF-8 encoded to the system clipboard.

• Icon: 

Advanced > Copy Values (BASE-64)

• Copies the selected values BASE-64 encoded to the system clipboard.

• Icon: 

Advanced > Copy Values (HEX)

• Copies the selected values HEX encoded to the system clipboard.
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• Icon: 

Advanced > Copy Name-Value-Pairs as LDIF

• Copies the selected attribute and values in LDIF format to the system clipboard.

• Icon: 

Advanced > Copy Search Filter

Builds search filters from the selected attributes and values. There are four options:

• Default

• Copies the selected attribute and value as LDAP search filter (attribute=value).

• Icon: 

• Enabled: If one value is selected.

• NOT

• Copies the selected attribute and value as LDAP NOT search filter (!(attribute=value)).

• Icon: 

• Enabled: If one value is selected.

• AND

• Copies the selected attributes and values as LDAP AND search filter (&(attribute1=value1)...
(attributeN=valueN)).

• Icon: 

• OR

• Copies the selected attributes and values as LDAP OR search filter (|(attribute1=value1)...
(attributeN=valueN)).

• Icon: 

Advanced > Delete Attributes

• Deletes all values of the selected attributes. Applicable to multi-valued attributes, if you want to delete
the complete attribute just select one value use this action.

• Icon: 

• Enabled: If values of multi-valued attributes are selected.

Edit Attribute Description

• Opens the  Edit Attribute wizard  . When changing the attribute description a add operation and a delete
operation is performed.
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• Enabled: If one attribut or value is selected.

• Shortcut: F6

Edit Value

• Edits the selected value using the default value editor. To change the default value editor see  Value
Editors preferences  .

• Enabled: If one value is selected.

• Shortcut: F7 or Enter

Edit Value With

• Depending on the selected value there could be alternate value editors. To edit the selected value with
another value editor choose one of the listed editors.

• Enabled: If one value is selected.

Edit Entry...

• Opens the  Editor Entry Wizard, used to edit the entry offline.

• Shortcut: F8

Reload Attributes

• Reloads the attributes of the current entry.

• Icon: 

• Shortcut: F5

Fetch Operational Attributes

• Loads the operational attributes of the current entry.

Properties

• Opens the Properties dialog with the  Attribute properties page  or  Value properties page  .

• Shortcut: Alt-Enter

2.3.4. LDIF Entry Editor Overview

The LDIF Entry editor allows you to view and edit an entry using its LDIF representation. An LDIF content
record is used to display all attributes and values.

You could add, modify and delete attributes. To save the modifications to the directory server you must
explicitly save the editor.

It is not possible to modify the distinguished name. It is also not possible to add change the record type
or to add additional records.
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Example screenshot

2.3.5. LDIF Entry Editor Context Menu

This section describes the context menu of the LDIF Entry editor.

Undo Typing

• Undo the last typing.

• Shortcut: Ctrl-Z

Revert File

• Reverts all unsaved modifications.

Save

• Saves the modified entry to the directory server.

• Shortcut: Ctrl-S

Cuts

• Cuts the selected text to the clipboard.

• Shortcut: Ctrl-X

Copy

• Copies the selected text to the clipboard.

• Icon: 

• Shortcut: Ctrl-C or Ctrl-Insert

Paste

• Pastes the content of the clipboard.
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• Icon: 

• Shortcut: Ctrl-V or Shift-Insert

Edit Attribute Description

• Opens the  Edit Attribute wizard.

• Enabled: If one attribute is selected.

• Shortcut: F6

Edit Value

• Edits the selected value using the default value editor. To change the default value editor see  Value
Editors preferences  .

• Enabled: If one value is selected.

• Shortcut: F7

Edit Value With

• Depending on the selected value there could be alternate value editors. To edit the selected value with
another value editor choose one of the listed editors.

• Enabled: If one value is selected.

Edit Record

• Opens the LDIF Record Editor dialog.

• Shortcut: F8

Reload Attributes

• Reloads the attributes of the current entry.

• Icon: 

• Shortcut: F5

Fetch Operational Attributes

• Loads the operational attributes of the current entry.

Preferences

• Opens the LDIF Editor preferences.

2.4. Search Result editor
The Search Result editor is used to view and edit search results. Although it is placed in the editor area
there is only a single instance of the Search Result editor.
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2.4.1. Overview

This section describes general aspects of the Search Result editor.

Example screenshot

Layout

The Search Result editor has a multi-column layout, one column for each returning attribute defined in
search parameters. Each line represents a search result with its values.

The cells have the following meaning:

• A value indicates that the entry has such an attribute with exacly one value.

• An empty cell indicates that the entry hasn't such an attribute.

• X values: ... indicates that the entry has multiple values for that attribute.

You can choose whether the DN of each search result is displayed as first column. Toggle Toolbar menu
-> Show DN .

Fonts and Colors

To distinguish the different attribute classes the Search Result editor uses the same fonts and colors as
the Entry editor .

Toolbar

The toolbar contains the following items:

Icon Action Description Shortcut

New Value Adds a new value to the selected attribute and
starts the edit mode.

Ctrl-+

Delete Deletes the selected attribute. Delete

Refresh Performs the current search. F5

Copy Table Copies values as displayed in the table as
CSV. By default the tabulator is used as
attribute delimiter, a pipe is used as value
delimiter and each attribute is wrapped by
double-quotes. These settings are suitable
to paste the copied data into Excel or
OpenOffice, the settings could be changed in
Text Formats preferences  .
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Icon Action Description Shortcut

Show Quick Filter Shows/Hides the  Quick Filter  . Ctrl-F

Drop Down Menu

The drop down menu contains the following items:

• Show DN: If checked the distinguished name of each search result is displayed as first column.

• DN as link: If checked the distinguished name of each search result is a link. Clicking to this link will
open the search result entry.

• Show Decorated Values: If checked decorated values are displayed, this means some additional
information is displayed:

• Images: Image format, width, height, and size.

• Binary data: Data size.

• Passwords: Used hash method.

• Timestamps: Locale dependent date and time format.
If unchecked the raw values (as stored in directory) are displayed.

• Preferences...: Opens the  Search Result editor preferences  dialog.

2.4.2. Features

This section describes the features of the Search Result editor.

Sorting

To sort the search results by attributes click the column header. The current sort attribute and direction
is indicated by an arrow.

Quick Filter

If there are many search results it is difficult to find a specific one. The Quick Filter provides a client-side
filter. To show/hide the Quick Filter toggle the  button or press Ctrl-F . Enter (even parts of) a value
into the input field, only matching search results keep displayed. When hiding the filter is removed.

Navigation

The  Locate DN in DIT action locates and opens the entry of a selected DN in the DIT.

The  Open Search Result action locates and opens the selected search result.
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Copy Table

The  Copy Table action copies attributes as displayed in the table to the system clipboard.

By default the tabulator is used as attribute delimiter, a pipe is used as value delimiter and each attribute is
wrapped by double-quotes. These settings are suitable to paste the copied data into Excel or OpenOffice,
the settings could be changed in  Text Formats preferences  .

Editing

It is possible to add, edit or delete the displayed attributes of the search results in the Search Result editor.

To enter the edit mode using the default value editor select a cell and press Enter or F7 or double-click
the cell. If the attribute is a simple string (like givenName or telephoneNumber) the value could be edited
in-place, otherwise a specific value editor dialog is opened. To use a specific value editor choose one from
Context Menu -> Edit Value With  .

To finish editing press Enter or click to another cell or click the OK button in a value editor dialog. To
cancel editing press ESC or click the Cancel button in a value editor dialog.

Multivalued Editor

In LDAP it is possible (and even normal) that an entry has multivalued attributes. To handle this in a
spreadsheet-like editor a special editor is necessary:

• In the cell a multivalued attribute is displayed as "X values: ..." to show the number of values and a
preview

• When entering edit mode the Multivalued Editor dialog is opened.

The Mulivalued Editor is similar to the Entry editor: you could add, edit and delete values. Of course it is
limited to edit only the current attribute, not the whole entry.

When editing a multivalued attribute the Multivalued Editor is used as default value editor. When editing
a singlevalued attribute you could select  Context Menu -> Edit Value With ->  Multivalued Editor  .

2.4.3. Context Menu

This section describes the context menu of the Search Result editor.

New Value

• Icon: 

• Description: Adds a new value to the selected attribute and starts the edit mode. If the attribute already
contains one or multiple values the Multivalued Editor is opened.

• Enabled: If an attribute is selected.

• Shortcut: Ctrl-+

New Search...

• Icon: 
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• Description: Opens the  Search dialog  . The selected attribute is used to build the search filter (Query
by example).

• Enabled: If an attribute is selected.

• Shortcut: Ctrl-H

New Batch Operation...

• Icon: 

• Description: Opens the  Batch Operation wizard  . If an attribute with one or multiple DNs values are
selected these DNs are used as operation objects. Otherwise the selected attribute is used to build the
search filter (Query by example).

• Enabled: If an attribute is selected.

Locate DN in DIT

• Icon: 

• Description: Locates the entry of the selected DN in DIT.

• Shortcut: F3

Open Search Result

• Icon: 

• Description: Locates and opens the search result.

• Shortcut: F4

Open Schema Browser -> Object Class Definition

• Icon: 

• Description: Opens the  Object Class page  in  Schema Browser  and selects the object class definition
of the currently selected objectClass attribute.

• Enabled: If the objectClass attribute is selected and the schema contains this object class.

Open Schema Browser -> Attribute Type Definition

• Icon: 

• Description: Opens the  Attribute Type page  in  Schema Browser  and selects the attribute type definiton
of the currently selected attribute.

• Enabled: If an attribute is selected and the schema contains this attribute type.

Open Schema Browser -> Equality Matching Rule Definition

• Icon: 
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• Description: Opens the  Matching Rule page  in  Schema Browser  and selects the equality matching
rule definiton of the currently selected attribute.

• Enabled: If an attribute is selected, the attribute provides an equality matching rule and the schema
contains this matching rule.

Open Schema Browser -> Substring Matching Rule Definition

• Icon: 

• Description: Opens the  Matching Rule page  in  Schema Browser  and selects the substring matching
rule definiton of the currently selected attribute.

• Enabled:If an attribute is selected, the attribute provides a substring matching rule and the schema
contains this matching rule.

Open Schema Browser -> Ordering Matching Rule Definition

• Icon: 

• Description: Opens the  Matching Rule page  in  Schema Browser  and selects the ordering matching
rule definiton of the currently selected attribute.

• Enabled: If an attribute is selected, the attribute provides an ordering matching rule and the schema
contains this matching rule.

Open Schema Browser -> Syntax Definition

• Icon: 

• Description: Opens the  Syntax page  in  Schema Browser  and selects the syntax definiton of the
currently selected attribute.

• Enabled: If an attribute is selected, the attribute provides an syntax and the schema contains this syntax.

Copy Values

• Icon: 

• Description: Copies the values of the selected attribute. The values are copied to clipboard in an internal
format so they could be pasted to another entry even in the entry editor. Additional they are copied to
the system clipboard as string so they could be pasted in other applications. New-line is used as value
separator. Binary values are copied BASE-64 encoded.

• Shortcut: Ctrl-C or Ctrl-Insert

Paste Values

• Icon: 

• Description: Pastes the previously copied values to the selected attribute.

• Enabled: If the system clipboard contains values.

• Shortcut: Ctrl-V or Shift-Insert
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Delete

• Icon: 

• Description: Deletes the selected attribute.

• Enabled: If an attributes is selected.

• Shortcut: Delete

Advanced -> Copy DN

• Icon: 

• Description: Copies the distinguished name of the current search result (e.g. cn=John
Fowler,ou=People,o=JNDITutorial)

Advanced -> Copy URL

• Icon: 

• Description: Copies the URL of the current search result (e.g. ldap://localhost:389/cn=John
Fowler,ou=People,o=JNDITutorial)

Advanced -> Copy Attribute Description

• Icon: 

• Copies the attribute description of the selected attribute as string to the system clipboard.

Advanced -> Copy Values (UTF-8)

• Icon: 

• Copies the selected values UTF-8 encoded to the system clipboard.

Advanced -> Copy Values (BASE-64)

• Icon: 

• Copies the selected values BASE-64 encoded to the system clipboard.

Advanced -> Copy Values (HEX)

• Icon: 

• Copies the selected values HEX encoded to the system clipboard.

Advanced -> Copy Name-Value-Pairs as LDIF

• Icon: 

• Copies the selected attribute in LDIF format to the system clipboard.
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Advanced -> Copy Search Filter

Builds search filters from the selected attribute. There are four options:

• Default

• Icon: 

• Description: Copies the selected attribute as LDAP search filter (attribute=value).

• Enabled: If a singlevalued attribute is selected.

• NOT

• Icon: 

• Description: Copies the selected attribute as LDAP NOT search filter (!(attribute=value)).

• Enabled: If a singlevalued value is selected.

• AND

• Icon: 

• Description: Copies the selected attribute as LDAP AND search filter (&(attribute1=value1)...
(attributeN=valueN)).

• OR

• Icon: 

• Description: Copies the selected attribute as LDAP OR search filter (|(attribute1=value1)...
(attributeN=valueN)).

Edit Value

• Edits the selected attribute using the default value editor. To change the default value editor see  Value
Editor preferences  .

• Enabled: If an attribute is selected.

• Shortcut: F7 or Enter

Edit Value With

• Depending on the selected attribute there could be alternate value editors. To edit the selected attribute
with another value editor choose one of the listed editors.

• Enabled: If an attribute is selected.

Search Again

• Icon: 

• Performs the search again.

• Shortcut: F5
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Properties

• Description: Opens the Properties dialog with the  attribute properties page  or  entry properties page  .

• Shortcut: Alt-Enter

2.5. Schema Browser
With the Schema Browser you can browse the schema with its schema elements like object classes,
attribute types, matching rules and syntaxes. It is placed in the editor area.

2.5.1. Overview

This section describes general aspects of the Schema Browser.

Example screenshot

Layout

The header of the Schema Browser contains the title and the toolbar. The toolbar shows the connection of
the currently displayed schema and a Browse... button to select another connection.

The Schema Browser consists of five pages:

• Object Classes page

• Attribute Type page

• LDAP Syntaxes page

• Matching Rules page

• Matching Rule Use page

Each page has a master-detail layout. The left part of a page shows a list of all schema elements (like
object class names or attribute types). To search a schema element you can filter the list by typing the
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name of the schema element into the filter input field. When selecting one schema element the right part
of the page shows the details.

Navigation

In the detail section references to other schema elements are displayed as hyperlinks. Click to the hyperlink
to jump to the target schema element.

Toolbar

The toolbar contains the following items:

Icon Action Description

Show Default Schema Shows the default schema instead of the schema of the
currently selected connection.

Reload Schema Reloads the schema of the currently selected connection.

2.5.2. Object Classes

The Object Classes page shows the object classes defined in schema.
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The left part of the page lists the available object classes.

The right part of the page shows the details of the selected object class:

• Details: Shows the OID, names, description and kind of the object class.

• MUST Attributes: Shows all MUST attributes, even those inherited from superclasses.

• MAY Attributes: Shows all MAY attributes, even those inherited from superclasses.

• Superclasses: Shows the object classes this object class is directly derived from (in other words the
parents).

• Subclasses: Shows the object classes derived from this object class (in other words the children).

• Raw Schema Definition: Shows the raw value of the object class definition as returned from server.

2.5.3. Attribute Types

The Attribute Types page shows the attribute types defined in schema.
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The left part of the page lists the available attribute types.

The right part of the page shows the details of the selected attribute type:

• Details: Shows the OID, names, description and usage of the attribute type.

• Flags: Shows if the attribute type is single-valued, read-only and/or collective. Non-matching flags are
greyed-out.

• Syntax: Shows the syntax OID and description and optional a length of the attribute type.

• Matching Rules: Shows the equality, substring and ordering matching rules of the attribute type.

• Other Matching Rules: Shows additional matching rules applicable to the attribute type.

• Used as MUST: Shows object classed where this attribute type is used as MUST.

• Used as MAY: Shows object classed where this attribute type is used as MAY.

• Supertype: Shows the attribute type where this attribute is derived from (in other words the parent).

• Subtypes: Shows attribute types derived from this attribute types (in other words the children).

• Raw Schema Definition: Shows the raw value of the attribute type definition as returned from server.

2.5.4. Syntaxes

The Syntaxes page shows the syntaxes defined in schema.

The left part of the page lists the available syntaxes.

The right part of the page shows the details of the selected syntax:
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• Details: Shows the OID description of the syntax.

• Used from: Shows attribute types using this syntax.

• Raw Schema Definition: Shows the raw value of the syntax definition as returned from server.

2.5.5. Matching Rules

The Matching Rules page shows the matching rules defined in schema.

The left part of the page lists the available matching rules.

The right part of the page shows the details of the selected matching rule:

• Details: Shows the OID, name and description of the matching rule.

• Syntax: Shows the syntax OID and description of the matching rule.

• Used from: Shows attribute types using this matching rule.

• Raw Schema Definition: Shows the raw value of the matching rule definition as returned from server.

2.5.6. Matching Rule Use

The Matching Rule Use page shows the matching rule uses defined in schema.
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The left part of the page lists the available matching rule use descriptions.

The right part of the page shows the details of the selected matching rule use:

• Details: Shows the OID, namees and description of the matching rules.

• Applies: Shows attribute types this matching rule applies to.

• Raw Schema Definition: Shows the raw value of the matching rule use definition as returned from server.

2.6. Modification Logs view
The Modification Logs view shows all sucessful and failed modifications.

Concept

All modify operations are logged to a logfile in LDIF format. Additionally the result (OK or ERROR) is
prepended as LDIF comment to every log record.

Example log of a sucessfully performed modification:
#!RESULT OK
#!CONNECTION ldap://localhost:389
#!DATE 2006-11-04T21:32:40.134
dn: cn=Ted Geisel,ou=People,o=JNDITutorial
changetype: modify
add: mail
mail: Ted.Geisel@JNDITutorial.com
-
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Example log of a failed modification:
#!RESULT ERROR
#!CONNECTION ldap://localhost:389
#!DATE 2006-11-04T21:33:05.739
#!ERROR [LDAP: error code 20 - modify/add: mail: value #0 already exists]
dn: cn=Ted Geisel,ou=People,o=JNDITutorial
changetype: modify
add: mail
mail: Ted.Geisel@JNDITutorial.com
-

The modification logging mechanism works with logfile rotation. By default 10 logfiles each with 100KB
per connection are used, you may change these settings in the  Modification Logs preferences .

Example screenshot

Toolbar

Icon Action Description

Clear Clears the current modification logfile.

Refresh Reloads the current modification logfile.

Older Loads an older modification logfile.

Newer Loads a newer modification logfile.

Export Modification Logs... Exports the modification logs to a file.

Drop Down Menu

The drop down menu contains the following items:
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• Enable Modification Logs: Enables/Disables the modification logs.

• Preferences...: Opens the  Modification Logs preferences  dialog.

2.7. Search Logs view
The Search Logs view shows all search requests and optionally all received search result entries.

Concept

All search requests are logged in LDIF to a logfile, it consists of three parts:

• The initial SEARCH REQUEST record. It contains all search request parameters like search filter, scope
and requested attributes. It also contains the command line argument that could be used to send the same
request using the ldapsearch command line tool.

• Optional multiple SEARCH RESULT ENTRY records, one for each received entry.

• The final SEARCH RESULT DONE record. It contains the number of received entries.

Each part contains a unique number that helps to put together all parts for a specific request in case that
there are multiple requests in parallel.

Example log of a SEARCH REQUEST record:
#!SEARCH REQUEST (112) OK
#!CONNECTION ldap://localhost:10389
#!DATE 2008-08-26T16:31:59.271
# LDAP URL : ldap://localhost:10389/dc=example,dc=com?
objectClass,cn,description?one?(objectClass=*)
# command line : ldapsearch -H ldap://localhost:10389 -x -D
"uid=admin,ou=system" -W -b "dc=example,dc=com" -s one -a always -z 1000
"(objectClass=*)" "objectClass" "cn" "description"
# baseObject : dc=example,dc=com
# scope : singleLevel (1)
# derefAliases : derefAlways (3)
# sizeLimit : 1000
# timeLimit : 0
# typesOnly : False
# filter : (objectClass=*)
# attributes : objectClass cn description

Example log of a SEARCH RESULT ENTRY record:
#!SEARCH RESULT ENTRY (112) OK
#!CONNECTION ldap://localhost:10389
#!DATE 2008-08-26T16:31:59.272
dn: cn=test,dc=example,dc=com
objectClass: person
objectClass: top
cn: test

Example log of a SEARCH RESULT DONE record:
#!SEARCH RESULT DONE (112) OK
#!CONNECTION ldap://localhost:10389
#!DATE 2008-08-26T16:31:59.273
# numEntries : 1
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The search logging mechanism works with logfile rotation. By default 10 logfiles each with 100KB per
connection are used, you may change these settings in the  Search Logs preferences

Example screenshot

Toolbar

Icon Action Description

Clear Clears the current search logfile.

Refresh Reloads the current search logfile.

Older Loads an older search logfile.

Newer Loads a newer search logfile.

Export Search Logs... Exports the search logs to a file.

Drop Down Menu

The drop down menu contains the following items:

• Enable Search Request Logs: Enables/Disables the search request and search result done logs.

• Enable Search Result Entry Logs: Enables/Disables the search result entry logs. Note: You should only
activate this options for debug reasons, otherwise your logfile will overfill very fast.

• Preferences...: Opens the  Search Logs preferences  dialog.

2.8. Progress view
Long-running operations, especially every access to directories, are executed in background. The Progress
view shows such pending operations.
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To cancel a long-running operation press the stop button.

3. Wizards and dialogs
3.1. New Connection wizard

This wizard helps you to create a new connection to a LDAP directory.

To start the wizard choose one of the following options:

• In the Connections view select the  New Connection... button or select New Connection... from the
context menu.

• In the Workbench window's toolbar, activate the drop-down menu on the New Wizard button and select
LDAP Connection

• In the Workbench menu bar select  File > New > LDAP Connection  .

The creation of a new LDAP connection is a four-step process:

1. Define network parameters.

2. Define authentication parameters.

3. Define additional browser options (optional).

4. Define additional edit options (optional).

Page 1

The first page allows you to enter a connnection name and the network parameters.
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Option Description Default

Connection name The name of the connection. In the Connections
view the connection is listed with this name. The
name must be unique.

empty

Hostname The hostname or IP address of the LDAP server.
A history of recently used hostnames is available
through the drop-down list.

empty

Port The port of the LDAP server. The default port for
non-encyrpted connections is 389. The default port
for ldaps:// connections is 636. A history of recently
used ports is available through the drop-down list.

389

Encryption method The encryption to use. Possible values are 'No
encrypton', 'ldaps://' and 'StartTLS extension'.

No encryption

Check network
parameter

Use this function if you want validate that the
entered information is correct and the server is
reachable.

-

Page 2

On the second page you could specify the authentication parameters.

Option Description Default

Authentication Method Select your authentication method between:

• Anonymous Authentication: connects to the
directory without authentication.

• Simple Authentication: uses simple
authentication using a bind DN and password, the
credentials are transmitted in clear-text over the
network.

Simple Authentication
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Option Description Default

• CRAM-MD5 (SASL): authenticates to
the directory using a challenge-response
authentication mechanism, the credentials are not
transmitted in clear-text over the network.

• DIGEST-MD5 (SASL): another challenge-
response authentication mechanism, additionally
you could define your realm and QoP parameters.

• GSSAPI (Kerberos): users Kerberos based
authentication, additional parameters could be
defined.

Bind DN or user The distinguished name or user ID used to bind.
Previously entered DNs could be selected from
drop-down list.

empty

Bind Password The password used to bind. empty

Save password If checked the password will be saved in
configuration. If not checked you have to enter
the password whenever you connect to the server.
Warning: The password is saved as plain text!

checked

Check Authentication Use this function if you want to attempt a connection
plus a bind to the host upon completion of the wizard
to validate that the entered information is correct.

-

Additional authentication parameters for SASL and Kerberos:

Option Description Default

SASL Realm The SASL Relam used to bind, only applicaple if
DIGEST-MD5 is choosen.

empty

Quality of Protection The QoP to use: authentication only, with integrity
protection, and with privacy protection

Authentication only

Protection Strength The protection strength to use High
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Option Description Default

Mutual Authentication If checked mutual authentication is used, that means
the server has to authenticate itself to the client. If
unchecked only the client authenticates itself to the
server.

unchecked

Use native TGT If checked the native credential cache is used, thus
no additional authentication is necessary. Note that
on Windows systems that requires a modification of
the registry.

checked

Object TGT from KDC If checked a new TGT is obtained from the KDC.
Username and password must be provided.

unchecked

Use native system
configuration

If checked the native Kerberos configuration is used
(e.g. /etc/krb5.conf).

checked

Use configuration file If checked a custom configuration file could be
used.

unchecked

Use following
configuration

If checked the Kerberos configuration parameters
(realm, host, port) could be set in the dialog.

unchecked

Page 3

On the third page you could enter additional browser options .

Option Description Default

Get base DNs from Root
DSE

If checked the base DNs are fetched from
namingContexts attribute of the Root DSE.

checked
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Option Description Default

Fetch Base DNs Use this function to get the namingContext values
from the Root DSE. The returned values will appear
in the 'Base DN' drop-down list.

-

Base DN The base DN to use. You may enter a DN manually
or you may select one from the drop-down list. This
field is only enabled if the option 'Get base DNs
from root DSE' is off.

empty

Count Limit Maximum number of entries returned from server
when browsing the directory, it is also used as
default value when searching the directory. A value
of 0 means no count limit. Note that this value is a
client-side value, its possible that also a server-side
limit is used.

1000

Time Limit The maximum time in seconds the server searches
for results. This is used as default value when
browsing or searching the directory. A value of 0
means no limit. Note that this value is a client-side
value, its possible that also a server-side limit is
used.

0

Alias Dereferencing Specifies whether aliases should be dereferenced
while finding the search base entry or when
performing the search or both. To manage (create,
modify, delete) alias objects you have to uncheck
both options.

Both finding and
searching

Referrals Handling Specifies the referral handling.

• Follow Referrals manually: Received referrals
and search continuations are just displayed in the
Browser. As soon as you open or expand such
an search continuation the search is continued.
You are asked which connection you want to
use to follow a specific referral URL, this way
you have full control regarding encryption and
authentication options when following referrals.

• Follow Referrals automatically: Follows referrals
and search continuations immediately if they are
received from the directory server. You are asked
which connection you want to use to follow a
specific referral URL, this way you have full
control regarding encryption and authentication
options when following referrals.

• Ignore Referrals: Any referral or search
continuation received from the directory server
is silently ignored. No error is logged, no dialog
appears, no special entry is displayed in the DIT,
no ManageDsaIT control is sent to the server.

Follow Referrals
manually

Use ManageDsaIT
control while browsing

If enabled the ManageDsaIT control is sent to
the server in each request. This signals the

unchecked
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Option Description Default

directory server to not send referrals and search
continuations, but return the special referral objects.
This only works if the directory server supports the
ManageDsaIT control.

Fetch subentries while
browsing

If enabled enabled both, normal and subentries
according to RFC 3672 are fetched. This causes
additional search requests while browsing the
directory.

unchecked

Paged Search If enabled the simple paged result control is used
while browsing the directory. With the page size you
could define how many entries should be retrieved
in one request. If Scroll Mode is enabled only
one page is fetched from the server at once while
browsing, you could 'scroll' through the pages by
using the 'next page' and 'top page' items. If disabled
all entries are fetched from the server, the paged
result control is only used in background to avoid
server-side limits.

unchecked

Fetch operational
attributes while browsing

If enabled enabled both, user attributes and
operational attributes are retrieved while browsing.
If the server supports the feature 'All Operational
Attributes' then a '+' is used to retrieve operational
attributes, otherwise all operational attributes
defined in the schema are requested.

unchecked

Page 4

On the fourth page you could enter additional edit options.

Option Description Default

Modify Mode Specify the modify mode for attributes with an
equality matching rule. Description of options:

• Optimized Modify Operations: uses add/delete
by default, uses replace if operation count is less

Optimized Modify
Operations



Tools

57

Option Description Default

• Always REPLACE: always uses replace
operations to perform entry modifications

• Always ADD/DELETE: always uses add and/or
delete operations to perform entry modifications

Modify Mode (no
equality matching rule)

Specify the modify mode for attributes with *no*
equality matching rule. Description of options:

• Optimized Modify Operations: uses add/delete
by default, uses replace if operation count is less

• Always REPLACE: always uses replace
operations to perform entry modifications

• Always ADD/DELETE: always uses add and/or
delete operations to perform entry modifications

Recommended values for various LDAP servers:

• ApacheDS: Optimized Modify Operations or
REPLACE

• OpenLDAP: REPLACE

• OpenDS / SunDSEE: Optimized Modify
Operations or REPLACE

• FedoraDS / 389DS: Optimized Modify
Operations (missing equality matching rules for
many standard attribute types)

• Active Directory: Optimized Modify Operations
(exposes no equality matching rules at all)

• eDirectory: Optimized Modify Operations
(exposes no equality matching rules at all)

Optimized Modify
Operations

Modify Order Specify the modify order when using add and delete
operations.

Delete first

3.2. New Entry wizard
This wizard helps you to create a new entry.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or search result or bookmark. Then choose  New > New
Entry... from context menu.

• In the Workbench window's toolbar, activate the drop-down menu on the New Wizard button and select
LDAP Entry

• In the Workbench menu bar select  File > New > LDAP Entry  .

The creation of a new LDAP entry is a four-step process:
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1. Select entry creation method.

2. Specify object classes of the new entry.

3. Specifiy the distinguished name of the new entry.

4. Enter attributes and values of the new entry.

Page 1

First you have to select the entry creation method.

With the option Create entry from scratch you could create a the new entry from scratch. All object
classes and attributes have to be specified in the wizard.

The option  Use existing entry as template  allows you to use an existing entry with its object classes and
attributes as template. The entry used as template could be specified in the input field:

• By default the DN of entry that was selected when the wizard has been started is used as template entry.

• You could manually edit the DN of the templayte entry.

• You could choose a previously used DN from drop-down list.

• By clicking Browse.... you could open a dialog to select the DN of the template entry.

Page 2

On the second page you have to choose the object classes of the new entry.
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The list Available object classes on the left side lists the object classes provided from schema of the
current connection. The list Selected object classes lists the object classes of the new entry. To add object
classed to the "selected" list select some in the "available" list and click the Add button. You could also
double-click an object class in the "available" list. To remove object classed from the "selected" list select
some in the "selected" list and click the Remove button. You could also double-click an object class in
the "selected" list.

Page 3

On the third page you have to define the distinguished name of the new entry.

The parent of the new entry could be specified in the input field:

• If you choosed the "from scratch" method the DN of entry that was selected when the wizard has been
started is used by default. If you choosed the "template" method the parent of the template entry is used
by default.
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• You could manually edit the parent DN.

• You could choose a previously used DN from drop-down list.

• By clicking Browse.... you could open a dialog to select the parent DN.

To specify the RDN select an attribute from the drop-down list and enter the value. If you choosed
the "template" method the RDN is preset with the RDN of the template entry. The wizard also support
multivalued RDNs. With the + and - buttons you can add and remove name-value pairs.

The DN preview field shows a preview of the DN.

When clicking to Next the wizard checks if an entry with the specified DN already exists. In that case you
have to change the DN of the new entry.

Page 4

On the fourth page you have to define the attributes of the new entry.

The layout and features are similar to the Entry editor. You could add, edit or delete attributes and values.

If you have choosed the "template" method all attributes of the template entry are already filled in the new
entry. Otherwise only the selected object classes and the RDN attribute are filled.

As soon as all MUST attributes are filled the Finish button is activated. When clicking the button the new
entry will be created in directory.

3.3. New Context Entry wizard
This wizard helps you to create a new context entry.

To start the wizard choose one of the following options:
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• In the LDAP Browser view select an entry or search result or bookmark. Then choose  New -> New
Context Entry... from context menu.

• In the Workbench window's toolbar, activate the drop-down menu on the New Wizard button and select
LDAP Context Entry

• In the Workbench menu bar select  File > New > LDAP Context Entry  .

The creation of a new LDAP entry is a four-step process:

1. Select entry creation method.

2. Specify object classes of the new context entry.

3. Specifiy the distinguished name of the new context entry.

4. Enter attributes and values of the new context entry.

Page 1

This page is identical to the New Entry wizard.

Page 2

This page is identical to the New Entry wizard.

Page 3

On the third page you have to define the distinguished name of the new entry.

The distinguished name the new context entry could be specified in the input field. The drop-down list
provides all available values from the Root DSE namingContexts attribute.

Page 4

This page is identical to the New Entry wizard.

3.4. Edit Entry wizard
This wizard helps you to edit an entry offline. You could make multiple modifications, when finishing
the wizard all your modifications are sent to the directory in one request. This wizard is especially helpful
when adding additional object classes which require additional attributes.
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To start the wizard choose Edit Entry... from the Entry editor's context menu or use the F8 shortcut.

The wizard is also the default value editor for the objectClass attribute, so you could also start the wizard
by editing the objectClass attribute.

Editing the LDAP entry is a two-step process:

1. Specify object classes of the entry.

2. Edit attributes and values of the entry.

Page 1

On the first page you could change the object classes of the entry.

The list Available object classes on the left side lists the object classes provided from schema of the
current connection. The list Selected object classes lists the object classes of the entry. To add object
classed to the "selected" list select some in the "available" list and click the Add button. You could also
double-click an object class in the "available" list. To remove object classed from the "selected" list select
some in the "selected" list and click the Remove button. You could also double-click an object class in
the "selected" list.

Page 2

On the second page you could change the attributes of the entry.
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The layout and features are similar to the Entry editor. You could add, edit or delete attributes and values.

As soon as all MUST attributes are filled the Finish button is activated. When clicking the button all
modifications will be sent to to the direcrory.

3.5. Attribute wizard

The Attribute wizard is used to create an attribute or to edit the attribute description of an existing attribute.

To create a new attribute select the  New Attribute... button in the Entry editor's tool bar or select New
Attribute... from the Entry editor's context menu or hit Shift-Strg-+.

To edit the attribute description select an attribute in the Entry editor and select Edit Attribute Description
from context menu or use the F6 shortcut.

Page 1

On the first page you have to enter the attribute type.
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Option Description Default

Attribute type The attribute type. Enter the
attribute type into the input field
or select one from drop-down-list.

Empty in New Attribute wizard,
filled in Edit Attribute Description
wizard.

Show subschema attributes only If checked the drop-down list
contains only attributes suitable to
the entry's subschema.

Checked

Hide existing attributes If checked the drop-down list
contains only attributes not yet
assigned to the entry.

Checked in New Attribute wizard,
unchecked in Edit Attribute
Description wizard.

Preview Shows a preview of the attribute
description.

-

Page 2

On the second page you could specify options.

Option Description

Language tags To provide language-specifc attributes you could use language tags if
supported by the directory. Enter a language code and optionally a country
code into the input fields or select values from drop-down lists. With the + and
- buttons you could add and remove tags.

Other options If needed you may enter specific options. With the + and - buttons you could
add and remove options.

Binary option If checked the binary option is added to attribute description.

Preview Shows a preview of the attribute description.

3.6. Search dialog
In the LDAP Search page you can specify search parameters to query a directory. It is integrated within
the Eclipse search dialog.

To start the LDAP Search page the following procedure is recommended:

1. Select a entry, search, attribute or value in the LDAP Browser view, in the Entry editor or in the Search
Result editor.
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2. Then choose   New Search...  from context menu or use the shortcut Ctrl-H or press the   Search
button in the Workbench toolbar.

Option Description Default

Search Name A meaningful name of the search. With this name the search
is listed in the Searches category.

Current timestamp

Connection The connection to search on. Use the  Browse...  button to
select a connection.

*)

Search Base The base DN of the search. You could edit the DN or select a
recently used DN from drop-down list or click to  Browse....
to open the DN Selector dialog.

*)

Filter Enter a valid LDAP search filter. The drop-down list provides
a history of recently used filters. A click to the  Filter Editor
button opens the Filter Editor dialog , it also explains how the
content assistance works.

*)

Returning
Attributes

A comma-separated list of attributes that should be returned
and displayed in the Search Result editor. Hit Strg-Space to
get content assistance. The drop-down list provides a history
of recently used attributes.

* )

ManageDsaIT If checked the ManageDsaIT control is sent to the server. unchecked

Subentries If checked the Subentries control (RFC 3672) is sent to the
server.

unchecked
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Option Description Default

Paged Search If checked the simple paged result control is sent to the server.
With the page size you could define how many entries should
be retrieved in one request. If Scroll Mode is enabled only
one page is fetched from the server at once, you could 'scroll'
through the pages by using the 'next page' and 'top page' items.
If disabled all entries are fetched from the server, the paged
result control is only used in background to avoid server-side
limits.

unchecked

Scope The search scope. Object searches on the base DN only
(compare); One Level searches the direct children of the base
DN; Subtree searches the base DN an all its descendants.

* )

Count Limit The maximum number of entries the server should return,
value 0 means no limit. Note that this value is a client-side
limit, its possible that also a server-side limit is used.

* )

Time Limit The maximum time in seconds the server should search. Value
0 means no limit. Note that this value is a client-side value, its
possible that also a server-side limit is used.

* )

Alias
Dereferencing

Specifies whether aliases should be dereferenced while finding
the search base entry or when performing the search or both. To
manage (create, modify, delete) aliases you have to uncheck
both options.

* )

Referrals Handling Specifies the referral handling.

• Follow Referrals manually: Received referrals and search
continuations are just displayed As soon as you open or
expand such an search continuation the search is continued.
You are asked which connection you want to use to
follow a specific referral URL, this way you have full
control regarding encryption and authentication options
when following referrals.

• Follow Referrals automatically: Follows referrals and
search continuations immediately if they are received from
the directory server. You are asked which connection you
want to use to follow a specific referral URL, this way you
have full control regarding encryption and authentication
options when following referrals.

• Ignore Referrals: Any referral or search continuation
received from the directory server is silently ignored. No
error is logged, no dialog appears, no special entry is
displayed, no ManageDsaIT control is sent to the server.

* )

* ) The default values depends on the element that was selected when the wizard has been started:

• Search: All search parameters are taken from the selected search

• Entry, search result or bookmark:

• Connection: the connection behind the entry

• Search Base: the entry's DN
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• Filter: (objectClass=*)

• Returning Attributes: -

• Scope: One Level

• Limits, aliases and referral handling are taken from the entry's connection

• Attribte and/or values:

• Connection: the connection behind attribute's entry

• Search Base: the DN of the attribute's entry

• Filter: The filter is build from the selected attributes and values (Query by example)

• Returning Attributes: -

• Scope: One Level

• Limits, aliases and referral handling are taken from connection behind attribute's entry

3.7. Batch Operation wizard

This wizard helps you to execute a batch operation to several entries.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or search. Then choose   New Batch Operation...  from
context menu.

• In the Workbench window's toolbar, activate the drop-down menu on the New Wizard button and select
  LDAP Batch Operation

• In the Workbench menu bar select  File > New >  LDAP Batch Operation  .

The execution of a batch operation is a four-step process:

1. Select entries where the batch operation should be applied to.

2. Select the operation type.

3. Specifiy the modifications.

4. Choose execution method.

Page 1

TODO..

Page 2

TODO..
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Page 3

TODO..

Page 4

TODO..

3.8. LDIF Import wizard

This wizard imports LDIF files into the directory. It supports LDIF content files as well as LDIF
modification files.

To start the wizard choose one of the following options:

• In the Connections view select a connection and choose  Import >  LDIF Import...  from context
menu.

• In the LDAP Browser view select an entry and choose  Import >  LDIF Import...  from context menu.

• In the Workbench menu bar select File > Import... and choose   LDIF into LDAP  .

Logging

When importing LDIF files the import operations could be logged. Every imported record is completely
written into logfile and the result (OK or ERROR) is prepended to every log record as LDIF comment.

Example log of a sucessfully imported record:
#!RESULT OK
#!CONNECTION ldap://localhost:389
#!DATE 2006-11-03T14:12:21.050
dn: cn=John Fowler,ou=Testdata,o=JNDITutorial
...

Example errol log:
#!RESULT ERROR
#!CONNECTION ldap://localhost:389
#!DATE 2006-11-03T14:12:21.050
#!ERROR [LDAP: error code 21 - telephoneNumber: value #0 invalid per
syntax]
dn: cn=John Fowler,ou=Testdata,o=JNDITutorial
...
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The wizard

Option Description Default

LDIF file The LDIF file to import. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Import into The connection into which the LDIF should be
imported. Use the  Browse...  button to select a
connection.

The connection that was
selected when the wizard
has been started.

Enable logging When checked every imported LDIF record is
logged into a logfile.

on

Use default logfile By default the extension ".log" is appended the
import filename.

on

Use custom logfile When checked you could specify a custom logfile. off

Overwrite existing
logfile

If the default or custom logfile already exist, you
must permit to overwrite the logfile.

off

Update existing entries This options applies for LDIF content records and
LDIF add records. If enabled and the entry to add
already exists it will be updated with the attributes
defined in the LDIF record. In detail a replace
operation for each attribute is performed. Attributes
of the existing entry that are not defined in the LDIF
record remain without modification.

off

Continue on error If checked the import process continues if an error
occurs while importing a record. If not checked the
import process interrupts.

off

3.9. DSML Import wizard

This wizard imports DSMLv2 files into the directory.

To start the wizard choose one of the following options:
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• In the Connections view select a connection and choose  Import >  DSML Import...  from context
menu.

• In the LDAP Browser view select an entry and choose  Import >  DSML Import...  from context
menu.

• In the Workbench menu bar select File > Import... and choose   DSML into LDAP  .

The wizard

Option Description Default

DSML file The DSML file to import. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Import into The connection into which the DSML should be
imported. Use the  Browse...  button to select a
connection.

The connection that was
selected when the wizard
has been started.

Save response When checked the response of the DSML request
execution is saved into a response file.

on

Use default response file By default the extension ".response.xml" is
appended the import filename.

on

Use custom response file When checked you could specify a custom response
file.

off

Overwrite existing
response file

If the default or custom response file already exist,
you must permit to overwrite the response file.

off

3.10. Import Connections wizard
This wizard imports previously exported connections to the Connections view.

To start the wizard select  Import >  Import Connections...  from the context menu of the Connections
view.
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On the wizard page you have to select the source file.

Option Description Default

From file The file containing all the connections. Type in the
full path or  Browse...  to select the path on the
file system. The drop-down list provides a history
of recently used files.

empty

3.11. LDIF Export wizard

This wizard is used to export entries to LDIF content files.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or a search and choose  Export >  LDIF Export...  from
context menu.

• In the Connections view select a connection and choose  Export >  LDIF Export...  from context
menu.

• In the Workbench menu bar select File > Export... and choose   LDAP to LDIF  .

Data to Export

On the Data to Export page you have to specify which entries and attributes to export.

The layout of the page is similar to the  LDAP Search page  . In the Returning Attributes section you
can also choose the following options:

Option Description Default

All user attributes Exports all user attributes. on if the Returning Attributes field
is empty

Operational attributes Exports all operational attributes. off

LDIF File

On the LDIF File page you have to select the target LDIF file.
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Option Description Default

LDIF File The LDIF file to export to. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Overwrite existing LDIF
file

If the export file already exist, you must permit to
overwrite the file.

off

Text Formats Opens the  Text Formats preferences  where you
could modify the LDIF format.

-

3.12. DSML Export wizard

This wizard is used to export entries to DSMLv2 files.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or a search and choose  Export >  DSML Export...  from
context menu.

• In the Connections view select a connection and choose  Export >  DSML Export...  from context
menu.

• In the Workbench menu bar select File > Export... and choose   LDAP to DSML  .

Data to Export

On the Data to Export page you have to specify which entries and attributes to export.

The layout of the page is similar to the  LDAP Search page  . In the Returning Attributes section you
can also choose the following options:

Option Description Default

All user attributes Exports all user attributes. on if the Returning Attributes field
is empty

Operational attributes Exports all operational attributes. off

DSML File

On the DSML File page you have to select the target DSML file.
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Option Description Default

DSML File The DSML file to export to. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Overwrite existing
DSML file

If the export file already exist, you must permit to
overwrite the file.

off

3.13. CSV Export wizard

This wizard is used to export entries to CSV files.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or a search and choose  Export >  CSV Export...  from
context menu.

• In the Connections view select a connection and choose  Export >  CSV Export...  from context menu.

• In the Workbench menu bar select File > Export... and choose   LDAP to CSV  .

Data to Export

On the Data to Export page you have to specify which entries and attributes to export.

The layout of the page is similar to the  LDAP Search page  . In the Returning Attributes section you
can also choose the following option:

Option Description Default

Export DN Exports the distinguished name as first column in
the CSV file.

on

CSV File

On the CSV File page you have to select the target CSV file.
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Option Description Default

CSV File The CSV file to export to. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Overwrite existing CSV
file

If the export file already exist, you must permit to
overwrite the file.

off

Text Formats Opens the  Text Formats preferences  where you
could modify the CSV format.

-

3.14. Excel Export wizard
This wizard is used to export entries to Excel files.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or a search and choose  Export >  Excel Export...  from
context menu.

• In the Connections view select a connection and choose  Export >  Excel Export...  from context
menu.

• In the Workbench menu bar select File > Export... and choose   LDAP to Excel  .

Data to Export

On the Data to Export page you have to specify which entries and attributes to export.

The layout of the page is similar to the  LDAP Search page  . In the Returning Attributes section you
can also choose the following option:

Option Description Default

Export DN Exports the distinguished name as
first column in the Excel file.

on

All user attributes Exports all user attributes. on if the Returning Attributes field
is empty

Operational attributes Exports all operational attributes. off

Excel File

On the Excel File page you have to select the target Excel file.
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Option Description Default

Excel File The Excel file to export to. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Overwrite existing Excel
file

If the export file already exist, you must permit to
overwrite the file.

off

Text Formats Opens the  Text Formats preferences  where you
could modify the Excel format.

-

3.15. ODF Export wizard
This wizard is used to export entries to OpenDocument Spreadsheet files.

To start the wizard choose one of the following options:

• In the LDAP Browser view select an entry or a search and choose  Export >  ODF Export...  from
context menu.

• In the Connections view select a connection and choose  Export >  ODF Export...  from context menu.

• In the Workbench menu bar select File > Export... and choose   LDAP to ODF  .

Data to Export

On the Data to Export page you have to specify which entries and attributes to export.

The layout of the page is similar to the  LDAP Search page  . In the Returning Attributes section you
can also choose the following option:

Option Description Default

Export DN Exports the distinguished name as
first column in the ODF file.

on

All user attributes Exports all user attributes. on if the Returning Attributes field
is empty

Operational attributes Exports all operational attributes. off

ODF File

On the ODF File page you have to select the target ODF file.
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Option Description Default

ODF File The ODF file to export to. Type in the full path or
Browse...  to select the path on the file system. The
drop-down list provides a history of recently used
files.

empty

Overwrite existing ODF
file

If the export file already exist, you must permit to
overwrite the file.

off

Text Formats Opens the  Text Formats preferences  where you
could modify the ODF format.

-

3.16. Connections Export wizard
This wizard is used to export all defined connections in the Connections view to a file.

To start the wizard select  Export >  Export Connections...  from the context menu of the Connections
view.

On the wizard page you have to select the target file.

Option Description Default

To file The file to export all the connections to. Type in
the full path or  Browse...  to select the path on the
file system. The drop-down list provides a history
of recently used files.

empty

Overwrite existing file If the export file already exist, you must permit to
overwrite the file.

off
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3.17. Select Referral Connection dialog
The Select Referral Connection dialog is used to select the target connection of an referral. If the host
and port one of the available connection matches the host and port of the referral URL this connection is
preselected. It is also possible to create a new connection for the referral.

3.18. Filter Editor dialog
To edit complex and nested filters you could use the filter editor dialog. It provides syntax highlighting,
content assistance and a formatter for nested filters.

Syntax coloring

Syntax coloring helps you to distinguish the different elements of an LDAP filter. The following colors
and fonts are used:

Element Color

opening and closing parenthesis black and bold

filter operator (& | !) green and bold

attribute violett

filter type red and bold

assertion value blue

Content assistance and code completion

The filter editor provides the following helpful features when editing an LDAP filter:

• Automatically adds and removes opening and closing parenthesis: just start typing the attribute or filter
operator.

• Hit Strg-Space to open a list of available code completions, press Esc to close the list.

• Attribute completion: when typing an attribute, e.g. "tel" a list with attributes that start with the "tel"
is opened.
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• Object class completion: if the attribute is objectClass a list with available object classes is opened.

• Matching rule completion: for filters with extensible matching a list with available matching rules is
provided.

Formatting

In the filter editor it is possible to format complex and nested filters. The formatter is invoked by pressing
the Format button and formats the filter the following way:

• Each filter item gets its own line.

• Each level of a nested filter is intended according to the level.

When opening the editor the filter is formatted automatically. When pressing OK the line breaks and white-
spaces are removed.

3.19. Rename Entry dialog
The Rename Entry dialog is used to rename an entry. In detail the relative distinguished name (RDN) is
modified by sending a modrdn operation to the directory.

To start the Rename Entry dialog select the entry you want to rename, then choose Rename... from context
menu or press F2.

Note 1: Some directories don't support renaming whole trees but only renaming of leaf entries. In that
case you are ask if you want to simulate the rename operation, this is done by copying the whole tree and
deleting the old tree afterwards.

Note 2: It is not possible to rename the Root DSE.

Option Description Default

RDN The new RDN of the entry. The drop-down list on
the left side contains possible attribute types. The
input field on the right side contains the attribute
value.

Current attribute type
and value
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Option Description Default

+ Adds a new name-value pair to RDN -

- Removes a name-value pair from RDN -

RDN Preview Shows a preview of the new RDN Current RDN

3.20. Move Entries dialog

The Move Entries dialog is used to move entries to another parent.

To start the Move Entries dialog select the entries you want to move, then choose Move... from context
menu.

Note 1: Some directories don't support moving whole trees but only moving of leaf entries. In that case
you are ask if you want to simulate the move operation, this is done by copying the whole tree and deleting
the old tree afterwards.

Note 2: It is not possible to move the root DSE.

Option Description Default

Parent The new parent of the entries. You could edit the DN
or select a recently used DN from drop-down list or
click to  Browse....  to open the DN Selector dialog.

The current parent

3.21. Go to DN dialog

The Goto DN dialog is used find an entry in the DIT by its distinguished name.

To start the Go to DN dialog choose Go to DN... from context menu.

Enter the DN of the entry into the input field and press OK.

3.22. Certificate Trust dialog

The Certificate Trust dialog pops up if a secure connection (ldaps or StartTLS) is established and the
validation of the server's certificate failed.
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Option Description

Dont't trust this certificate. If you don't trust the certificate choose this option, the connection
won't be established

Trust this certificate for this
session.

The certificate is only valid within this session and added to
the temporary certificate store. After a restart of Studio you are
asked again You could see all temporary trusted certificates in the
Certificate Validation preferences.

Always trust this certificate. The certificate is permanently valid and added to the permanent
certificate store. You could see all permanent trusted certificates in
the  Certificate Validation preferences

View Certificate... Opens the Certificate Viewer dialog, where you could examine the
certificate.
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4. Value Editors

4.1. Concept
An LDAP entry contains different attribute types with different syntaxes: objectClasses, names, passwords,
images, etc. To handle the different data types Value Editors are used. Value Editors know how to edit
a value .

The default Value Editor for an attibute is determined using the following procedure:

1. If a Value Editor for the attribute type is specified, this one is used.

2. If a Value Editor for the attribute's syntax is specified, this one is used.

3. If the attribute is binary according to its syntax, the Binary Editor is used.

4. If the attribute is string according to its syntax, the Text Editor is used.

The default Value Editor could be specified by attribute type or syntax in the Value Editors preferences

Another task of a Value Editor is to provide the displayed value for the Entry editor and Search Result
editor. Especially binary data can't be displayed "as-is".

4.2. In-Place Text Editor
The In-Place Text Editor is the default editor for string values without line breaks.

Display value

Values are displayed as stored in directory:
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Edit value

Values are edited directly within the entry editor or search result editor. To save the new value press Enter
or click somewhere outside the edit field. To cancel the modification press Esc.

4.3. Text Editor
The Text Editor is the default editor for string values with line breaks.

Display value

Values are displayed as stored in directory:

Edit value

Values are edited in a dialog which provides a simple text area. To finish editing press OK to save the
new value or Cancel to discard your modification.

4.4. Hex Editor
The Hex Editor is the default editor for binary values.

Display value

The displayed value "Binary Data" indicates that the value contains binary data, additional the size in
bytes is shown.

Edit value

The Hex Editor dialog displays the binary data as hex. To create or modify a value load the binary data
from a file using the Load data... button.
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Save value

You could also save the current binary data to a file with the Save data... button.

4.5. Password Editor

The Password Editor is the default editor for passwords.

Display value

The real password isn't displayed but only the encryption method.

Details

In the Current Passord tab you see some details about the password.

The current password could also be verified. Enter the compare password into the Verify Password field.
The Verify function compares the current password with the hashed value of the entered password. The
Bind function binds to the directory using the DN of the current entry and the entered password.
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Edit value

In the New Passord tab you can enter a new passord. Type in the password in the input field and select a
hash (encryption) method. The preview field shows the resulting password.

4.6. Image Editor
The Image Editor is the default editor for images.

Display value

The image type, width, height and size in bytes is used as display value.

Details

In the Current Image tab you see the image and some details about it.

You could also save the current image to a file with the Save... button.

Edit value

In the New Image tab you can load a new image from a file using the Browse... button.
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4.7. Object Class Editor
The Object Class Editor is the default editor for the objectClass attribute.

Display value

The objectClass name and the type of object class (structural, auxiliary, abstract) is used as display value.

Edit value

In the Object Class Editor dialog you can select the available object classes from a drop-down list.

4.8. Address Editor
The Address Editor is the default editor for attributes with postal address syntax. In the postal address
syntax the dollar character '$' is used as line separator.

Display value

Values are displayed as stored in directory, dollar characters are replaced by commas.
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Edit value

Values are edited in a dialog which provides a simple text area. Dollar characters are replaced by line
breaks.

4.9. DN Editor

The DN Editor is the default editor for attributes with distinguished name syntax.

Display value

Values are displayed as stored in directory.

Edit value

The edit dialog looks as follows:

To edit the DN you can use the following options:

• You could manually edit the DN in the input field.

• You could choose a previously used DN from drop-down list.

• By clicking  Parent the parent DN of the current DN appears in the input field.

• Browse.. opens a DN Selector, similar to the LDAP Browser. You can browse and filter to find an entry.
When selecting an entry its DN appears int the input field.
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4.10. Date & Time Editor

The Date & Time Editor is the default editor for attributes with generalized time syntax.

Display value

The values are converted to local time.

Edit value

The edit dialog looks as follows:

To edit date and time you have the following options:

• You could set the time, pick a date from the calendar and choose a time zone.

• You could manually edit the raw value in the input field.
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4.11. OID Editor

The OID Editor is the default editor for attributes with OID syntax.

Display value

The values are suffixed with the textual description of the OID.

Edit value

The In-Place Text Editor is used to edit values.

4.12. Certificate Editor

The Certificate Editor is the default editor for certificates.

Display value

The certificate type, version and owner are displayed.

Certificate Editor Dialog

The full certificate data could be exampined in the Certificate Editor dialog. Load data... button.

You could also save the current certificate to a file with the Save Certificate... button.
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To modify the certificate in the directory server load the new certificate from a file using the Load
Certificate... button and press the OK. button.

5. Properties

5.1. Connection properties

The following properties can be modified on the Connection properties pages:

Network Parameter

Field Description

Connection name The name of the connection. In the Connections view the connection
is listed with this name. The name must be unique.

Hostname The hostname or IP address of the LDAP server. A history of recently
used hostnames is available through the drop-down list.

Port The port of the LDAP server. The default port for non-encyrpted
connections is 389. The default port for ldaps:// connections is 636. A
history of recently used ports is available through the drop-down list.

Encryption method The encryption to use. Possible values are 'No encrypton', 'ldaps://'
and 'StartTLS extension'.

Check Network Parameter Use this function if you want validate that the entered information is
correct and the server is reachable.
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Authentication

Field Description

Authentication Method Select your authentication method between:

• Anonymous Authentication: connects to the directory without
authentication.

• Simple Authentication: uses simple authentication using a bind DN
and password, the credentials are transmitted in clear-text over the
network.

• CRAM-MD5 (SASL): authenticates to the directory using a
challenge-response authentication mechanism, the credentials are
not transmitted in clear-text over the network.

• DIGEST-MD5 (SASL): another challenge-response authentication
mechanism, additionally you could define your realm and QoP
parameters.

• GSSAPI (Kerberos): users Kerberos based authentication,
additional parameters could be defined.

Bind DN or user The distinguished name or user ID used to bind. Previously entered
DNs could be selected from drop-down list.

Bind Password The password used to bind.

Save password If checked the password will be saved in configuration. If not checked
you have to enter the password whenever you connect to the server.
Warning: The password is saved as plain text!
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Field Description

Check Authentication Use this function if you want to attempt a connection plus a bind to
the host upon completion of the wizard to validate that the entered
information is correct.

Additional authentication parameters for SASL and Kerberos:

Option Description

SASL Realm The SASL Relam used to bind, only applicaple if DIGEST-MD5 is
choosen.

Quality of Protection The QoP to use: authentication only, with integrity protection, and
with privacy protection

Protection Strength The protection strength to use

Mutual Authentication If checked mutual authentication is used, that means the server
has to authenticate itself to the client. If unchecked only the client
authenticates itself to the server.

Use native TGT If checked the native credential cache is used, thus no additional
authentication is necessary. Note that on Windows systems that
requires a modification of the registry.

Object TGT from KDC If checked a new TGT is obtained from the KDC. Username and
password must be provided.

Use native system configuration If checked the native Kerberos configuration is used (e.g. /etc/
krb5.conf).

Use configuration file If checked a custom configuration file could be used.

Use following configuration If checked the Kerberos configuration parameters (realm, host, port)
could be set in the dialog.
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Browser Options

Field Description

Get base DNs from Root DSE If checked the base DNs are fetched from namingContexts attribute
of the Root DSE.

Fetch Base DNs Use this function to get the namingContext values from the Root DSE.
The returned values will appear in the 'Base DN' drop-down list.

Base DN The base DN to use. You may enter a DN manually or you may select
one from the drop-down list. This field is only enabled if the option
'Get base DNs from root DSE' is off.

Count Limit Maximum number of entries returned from server when browsing the
directory, it is also used as default value when searching the directory.
A value of 0 means no count limit. Note that this value is a client-side
value, its possible that also a server-side limit is used.

Time Limit The maximum time in seconds the server searches for results. This
is used as default value when browsing or searching the directory. A
value of 0 means no limit. Note that this value is a client-side value,
its possible that also a server-side limit is used.

Alias Dereferencing Specifies whether aliases should be dereferenced while finding the
search base entry or when performing the search or both. To manage
(create, modify, delete) alias objects you have to uncheck both
options.

Referrals Handling Specifies the referral handling.

• Follow Referrals manually: Received referrals and search
continuations are just displayed in the Browser. As soon as you
open or expand such an search continuation the search is continued.
You are asked which connection you want to use to follow a
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Field Description

specific referral URL, this way you have full control regarding
encryption and authentication options when following referrals.

• Follow Referrals automatically: Follows referrals and search
continuations immediately if they are received from the directory
server. You are asked which connection you want to use to follow
a specific referral URL, this way you have full control regarding
encryption and authentication options when following referrals.

• Ignore Referrals: Any referral or search continuation received from
the directory server is silently ignored. No error is logged, no dialog
appears, no special entry is displayed in the DIT, no ManageDsaIT
control is sent to the server.

Use ManageDsaIT control while
browsing

If enabled the ManageDsaIT control is sent to the server in each
request. This signals the directory server to not send referrals and
search continuations, but return the special referral objects. This only
works if the directory server supports the ManageDsaIT control.

Fetch subentries while browsing If enabled enabled both, normal and subentries according to RFC 3672
are fetched. This causes additional search requests while browsing the
directory.

Paged Search If enabled the simple paged result control is used while browsing
the directory. With the page size you could define how many entries
should be retrieved in one request. If Scroll Mode is enabled only one
page is fetched from the server at once while browsing, you could
'scroll' through the pages by using the 'next page' and 'top page' items.
If disabled all entries are fetched from the server, the paged result
control is only used in background to avoid server-side limits.

Fetch operational attributes while
browsing

If enabled enabled both, user attributes and operational attributes
are retrieved while browsing. If the server supports the feature 'All
Operational Attributes' then a '+' is used to retrieve operational
attributes, otherwise all operational attributes defined in the schema
are requested.
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Edit Options

Field Description

Modify Mode Specify the modify mode for attributes with an equality matching rule.
Description of options:

• Optimized Modify Operations: uses add/delete by default, uses
replace if operation count is less

• Always REPLACE: always uses replace operations to perform
entry modifications

• Always ADD/DELETE: always uses add and/or delete operations
to perform entry modifications

Modify Mode (no equality
matching rule)

Specify the modify mode for attributes with *no* equality matching
rule. Description of options:

• Optimized Modify Operations: uses add/delete by default, uses
replace if operation count is less

• Always REPLACE: always uses replace operations to perform
entry modifications

• Always ADD/DELETE: always uses add and/or delete operations
to perform entry modifications

Recommended values for various LDAP servers:

• ApacheDS: Optimized Modify Operations or REPLACE

• OpenLDAP: REPLACE
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Field Description

• OpenDS / SunDSEE: Optimized Modify Operations or REPLACE

• FedoraDS / 389DS: Optimized Modify Operations (missing
equality matching rules for many standard attribute types)

• Active Directory: Optimized Modify Operations (exposes no
equality matching rules at all)

• eDirectory: Optimized Modify Operations (exposes no equality
matching rules at all)

Modify Order Specify the modify order when using add and delete operations.

Root DSE

The Root DSE properties page provides information about the connected directory server like directory
type and version, controls, extensions and features.

Schema
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The Schema properties page provides some information about the schema. The 'Schema Information' group
shows the schema DN an modification timestamp. With the 'Reload Schema' button a schema reload could
be forced, the schema is reloaded automatically if the directory's schema is newer than the cached one.
The 'Schema Cache' group shows information about the cached schema.

5.2. Entry properties

The Entry properties page shows some information about the entry.

The first two lines shows the DN and LDAP-URL of the entry.

The 'Create and Modify Information' group shows the create and modify timestamp and DN. If no values
are shown use the 'Refresh' button to load the attributes.

The 'Sizing Information' group shows information about the entry size in bytes, the number of children,
attributes and values. To take operational attributes into account check 'Include operational attributes'. The
'Refresh' button reloads the attributes and counts children.

You could select and copy all displayed information.

5.3. Attribute properties

The Attribute properties page shows some information about the attribute.
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The first four lines shows the attribute description, the type (String or Binary), the values count and the
size in bytes.

The next four groups shows the attribute's schema definition, similar to the Attribute Type schema page.

You could select and copy all displayed information.

5.4. Value properties
The Values properties page shows some information about the value.

Field Description

Attribute Description The attribute description of the attribute
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Field Description

Value Type String or Binary

Value Size If Binary the size in bytes. If String the number of characters and the
size in bytes. These two number could differ if the value contains
multibyte characters.

Data Nothing if Binary. If String the raw value as returned form server.

You could select and copy all displayed information.

5.5. Search properties

The layout of the Search properties page is similar to the Search dialog. All fields except the connection
could be modified.

5.6. Bookmark properties

In the Bookmark properties page you can modify the bookmark name and target entry.
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6. Preferences

6.1. Connections

In the Connections preferences page you can configure general settings for LDAP Connections.
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Option Description Default

JNDI LDAP Context
Factory

Apache Directory Studio uses JNDI for LDAP
access. This parameter configures the the factory
class. Normally this value is automatically detected
and there is no need to change it.

auto-detected

User Kerberos System
Properties

If checked you need to configure Kerberos
(GSSAPI) authentication using system properties,
see http://java.sun.com/products/jndi/tutorial/ldap/
security/gssapi.html for details.

unchecked

Kerberos Login Module Apache Directory Studio uses JAAS for Kerberos
authentication. This parameter configures the JAAS
login modul. Normally this value is automatically
detected and there is no need to change it.

auto-detected

6.2. Certificate Validation

In the Certificate Validation preferences page you can configure certificate validation settings.
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If Validate certificates for secure LDAP connections is checked, Apache Directory Studio checks
certificates when a secure LDAP connection (ldaps or StartTLS) is established. The following checks are
performed: a valid certification path with a trusted root CA must exist, the certificate must not be expired,
the hostname must match the certificate subject common name, the certificate must not be self-signed.

If validation fails the  Certificate Trust dialog pops up and the you could manually trust a certificate. Those
certificates are listed in the "Permanent Trusted" and "Temporary Trusted" lists. You could examine those
certificates using the View button. You can remove certificates if you don't trust them any more using
the Remove button.

6.3. Attributes preferences

In the Attributes preferences page you can configure general settings for attributes.
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By default non-text attributes are displayed in a user-friendly way within the Entry editor and the Search
Result editor. For example if an attribute contains a timestamp it is displayed in your local date format.
When unchecking the option Show decorated values the values are displayed as returned from directory.

In the Attribute Colors and Fonts group you can define the style how attributes and values are displayed
within the Entry editor and the Search Result editor.

6.4. Binary Attributes preferences

In the Binary Attributes preferences page you can configure which attributes are binary.

You can specify binary attributes by attribute type or by syntax.

6.5. Entry Editors preferences

In the Entry editor preferences page you can configure the behavior of the Entry editors.
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With the open mode you could define how the entry editor should be opened while browsing through the
DIT.

In the entry editors section you could define your preferred order of available entry editors using the Up/
Down buttons. The topmost entry editor in the list is the default entry editor.

6.6. Table Entry Editor preferences

In the Table Entry Editor preferences page you can configure the behavior of the Table Entry Editor.
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Option Description Default

Enable folding If checked attributes with many values are folded. on

Folding threshold The threshold when folding should be activated. 10

Auto-expand folded
attributes

If checked folded attribute are automatically
expanded.

off

Save modifications
automatically in single-
tab editor

If checked the single-tab editor automatically saves
any modification immediately and sends a modify
request to the LDAP server. If unchecked you
need to save the editor manually in order to save
modifications.

on

Save modifications
automatically in multi-
tab editor

If checked the multi-tab editor automatically saves
any modification immediately and sends a modify
request to the LDAP server. If unchecked you
need to save the editor manually in order to save
modifications.

off

6.7. Search Result editor preferences

In the Search Result editor preferences page you configure the behavior of the Search Result editor.
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Option Description Default

Show DN as first column If checked the distinguished name of each search
result entry is displayed as first line.

on

Show DN as link If checked the distinguished name of each search
result entry is displayed as a link.

on

6.8. Text Formats preferences
In the Text Formats preferences page you configure the text formats of LDIF, CSV and Excel files.

LDIF

In the LDIF tab you can configure the LDIF format.
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Option Description Default

Line Separator Select the line spearator to use for LDIF files.
Possible values are Windows, Unix

The platform specific
line separator

Line length The line length in LDIF files. 76

Space after colon If checked a space in inserted between the colon and
the value.

on

CSV Copy

In the CSV Copy tab you can configure the format used when copying CSV to clipboard (Copy Entry as
CSV, Copy Table).

Option Description Default

Attribute Delimiter The character used to separate attributes. Select
default or one from the drop-down box or enter a
custom character.

Tabulator (ASCII 9)

Value Delimiter The character used to separate values of multi-
valued attributes. Select default or one from the
drop-down box or enter a custom character.

Pipe (|)

Quote Character Each attribute is enclosed by this quote character.
Select default or one from the drop-down box or
enter a custom character.

Double Quote (")

Line Separator Select the line spearator to use. Possible values are
Windows, Unix

The platform specific
line separator

Binary Encoding When copying binary values they must be encoded.
Choose

• Ignore: if binary values should not be copied.

• BASE-64: to copy the binary values BASE-64
encoded.

Ignore
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Option Description Default

• HEX: to copy the HEX representation of each
byte.

CSV Export

In the CSV Export tab you can configure the format used when exporting to CSV.

Option Description Default

Attribute Delimiter The character used to separate attributes. Select
default or one from the drop-down box or enter a
custom character.

Comma (,)

Value Delimiter The character used to separate values of multi-
valued attributes. Select default or one from the
drop-down box or enter a custom character.

Pipe (|)

Quote Character Each attribute is enclosed by this quote character.
Select default or one from the drop-down box or
enter a custom character.

Double Quote (")

Line Separator Select the line spearator to use. Possible values are
Windows, Unix

The platform specific
line separator

Binary Encoding When exporting binary values they must be
encoded. Choose

• Ignore: if binary values should not be exported.

• BASE-64: to export the binary values BASE-64
encoded.

• HEX: to export the HEX representation of each
byte.

Ignore

File Encoding The file encoding used to when exporting to CSV.
Select default or one from the drop-down box.

The platform specific file
encoding
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Excel Export

In the Excel Export tab you can configure the format used when exporting to Excel.

Option Description Default

Value Delimiter The character used to separate values of multi-
valued attributes. Select default or one from the
drop-down box or enter a custom character.

Pipe (|)

Binary Encoding When exporting binary values they must be
encoded. Choose

• Ignore: if binary values should not be exported.

• BASE-64: to export the binary values BASE-64
encoded.

• HEX: to export the HEX representation of each
byte.

Ignore

ODF Export

In the ODF Export tab you can configure the format used when exporting to Open Document Spreadsheet
format.
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Option Description Default

Value Delimiter The character used to separate values of multi-
valued attributes. Select default or one from the
drop-down box or enter a custom character.

Pipe (|)

Binary Encoding When exporting binary values they must be
encoded. Choose

• Ignore: if binary values should not be exported.

• BASE-64: to export the binary values BASE-64
encoded.

• HEX: to export the HEX representation of each
byte.

Ignore

6.9. Value Editors preferences

In the Value Editors preferences page you can configure which value editor to use for an attribute.
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You can specify value editors by attribute type or by syntax. If a value editor is specified by syntax the
value editor is used for all attributes with this syntax. A value editor specified for an attribute overwrites
the syntax-setting.

6.10. Browser View preferences

In the Browser View preferences page you can configure the layout and behavior of the LDAP Browser
view and the Select DN dialog.
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Option Description Default

Entry label Choose one of DN, RDN or RDN value to be
used as label for entries in the DIT category. If the
checkbox is checked long labels with more than the
specified number of characters are abbreviated.

RDN with limit of 50
characters

Search Result label Choose one of DN, RDN or RDN value to be used
as label for search results in the DIT category. If the
checkbox is checked long labels with more than the
specified number of characters are abbreviated.

DN with limit of 50
characters

Folding If checked large subtrees and search results are
folded into virtual folders each with the given
number of entries.

enabled with folding size
100

Expand base entries
when opening
connection

If checked the base entries are expanded when
opening the connection.

off

Check for children If checked the LDAP Browser tries to find out
if the fetched entries have children. Therefore
the operational attributes hasSubordinates,
numSubordinates and subordinateCount are
requested from server.

on

6.11. Modification Logs View preferences

In the Modification Logs preferences page you can configure the behavior of the Modification Logs view
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Option Description Default

Enable modificaton logs Enables/Disables the modificaton logs. on

Masked Attributes Enter a comma-separated list of attributes that
should be masked by an asterisk '*'. A typical
attribute to mask is userPassword.

Log File Rotation Log file rotation is used. You could specifiy the
number of log files an the maximum size for each
log file.

10 log files each with 100
kB

6.12. Search Logs View preferences

In the Search Logs preferences page you can configure the behavior of the Search Logs view
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Option Description Default

Enable search request
logs

Enables/Disables the search request and search
result done logs.

on

Enable search result
entry logs

Enables/Disables the search result entry logs. Note:
You should only activate this options for debug
reasons, otherwise your logfile will overfill very
fast.

off

Log File Rotation Log file rotation is used. You could specifiy the
number of log files an the maximum size for each
log file.

10 log files each with 100
kB
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Chapter III. Tasks
1. Managing connections

1.1. Creating a connection

Using the New Connection wizard

To create a new connection please use the New Connection wizard.

Duplicating an existing connection

It is also possible to duplicate an existing connection. This is helpful if the new connection has similar
connection parameters:

1. Select the connection you want to duplicate and select  Copy Connection from context menu or use
the Strg-C shortcut.

2. Afterward select  Paste Connection from context menu or use the Strg-V shortcut. Observe the new
connection, prefixed with "Copy of ".

3. Rename the connection to your needs.

4. Modify the connection parameters to your needs.

1.2. Modifying connection parameters
The connection parameters could be modified in the Connection properties. Select a connection and choose
Properties... from context menu or press Alt-Enter to open the properties dialog.

Note: A connection must be closed in order to modify its connection parameters.

1.3. Renaming a connection
To rename a connection select a connection and choose Rename Connection... from context menu or
press F2.

In the opened dialog enter the new name and press OK.

1.4. Deleting a connection

To delete a connection select a connection and choose  Delete Connection from context menu or press
Delete.

Note: A connection must be closed in order to delete it.

1.5. Opening a connection
A connection is automatically opened when expanding the DIT or when performing a search.
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To open a connection explicitely choose one of the following options:

• In the Connections view select a connection and choose  Open Connection from context menu or
from toolbar.

• Double-click a connection.

1.6. Closing a connection

To close a connection select a connection and choose  Close Connection from context menu or from
toolbar.

1.7. Enabling secure connections
Apache Directory Studio supports secure connections using SSL (ldaps) or StartTLS extended operation.
Select a proper encryption method in the Connection properties.

1.8. Sharing connections
There are two ways to export and import connections. This may be useful if you want to copy your
connections from one computer to another or if you want to share connection parameters with other users.
You could also use this features to backup your defined connections.

Import/Export connections

You could use the Export Connection wizard and Import Connection wizard to export and import
connections.

Copy/Paste connections as LDAP URL

A more simple way is to copy/paste connections as LDAP URL.

RFC 2255 specifies the LDAP URL format. Apache Directory Studio uses the host and port field and uses
X- extensions for all other connection paramter.

Parameter Description Possible values Default

X-CONNECTION-
NAME

The connection name. Any name, must be URL
encoded

Current date

X-ENCRYPTION The encryption to use. none, ldaps, StartTLS none

X-AUTH-METHOD The authentication to
use.

Anonymous, Simple,
DIGEST-MD5, CRAM-
MD5

Simple imf X-BIND-
USER is present, else
Anonymous

X-BIND-USER The bind DN or user. Any DN, must be URL
encoded

none

X-BIND-PASSWORD The bind password. none

X-SASL-REALM The SASL realm. none

X-BASE-DN The base DN. A valid base DN, none
to get base DNs from the
Root DSE

none
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Parameter Description Possible values Default

X-COUNT-LIMIT The count limit. A positive integer, 0 for
no count limit

0

X-TIME-LIMIT The time limit in
seconds.

A positive integer, 0 for
no time limit

0

X-ALIAS-HANDLING The alias handling
method.

NEVER, SEARCHING,
FINDING, ALWAYS

ALWAYS

X-REFERRAL-
HANDLING

The referral handling
method.

FOLLOW, IGNORE,
MANAGE

FOLLOW

X-FETCH-
SUBENTRIES

If present the subentries
control is activated.

no value -

X-PAGED-SEARCH If present the paged
control is activated.

no value -

X-PAGED-SEARCH-
SIZE

The paged search size. Any positive integer 100

X-PAGED-SEARCH-
SCROLL-MODE

If present the scroll mode
is activated.

No value -

Here's an example how such an URL looks like: ldap://localhost:10389/????X-CONNECTION-
NAME=ApacheDS,X-BIND-USER=uid=admin%2cou=system,X-BIND-PASSWORD=secret,X-
COUNT-LIMIT=1000

When you copy a connection within the Connections view it is copied in the described format to your
clipboard. You could then paste this LDAP URL into a text editor or to an email.

The same way you could copy an LDAP URL from somewhere and paste it into the Connections view.

2. Browsing directory

2.1. Handling large number of entries
A directory may have entries with thousands of child entries. It is not recommended to fetch all these
children when browsing because this increases directory and network load and is very time consuming.

Limiting number of fetched entries

It is recommended to limit the number of returned entries. The limit is defined in Connection properties.

Filtering children

Another option is to use a filter to limit the fetched children. Choose  Filter Children... from context
menu. In the opened dialog you could define a LDAP filter. Hit Strg-Space to get content assistance. The
drop-down list provides a history of recently used filters. A click to the  Filter Editor  button opens the
Filter Editor dialog.

2.2. Showing RootDSE and Schema entry
To make RootDSE and Schema entry visible in the Browser view enable Show Directory Metadata in
the Browser's drop down menu.
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2.3. Showing subentries
Subentries are a special kind of entries used for managing the administration of different aspects of
the directory. By default they are not visible. To make them visible in the Browser view enable Fetch
subentries in the Connection properties.

2.4. Displaying entry's attribute
Select an entry in the Browser view. The Entry editor will be opened and shows the entry's attributes.

2.5. Filtering entry's attribute
Please see  Quick Filter  in Entry editor features.

3. Managing entries

3.1. Creating an entry
To create a new entry please use the New Entry wizard.

3.2. Renaming an entry
To rename an entry please use the Rename Entry dialog.

3.3. Moving entries
To move entries to another parent please use the Move Entry dialog.

3.4. Deleting entries
To delete entries select the entries you would like to delete and choose  Delete from context menu or
press Delete key.

3.5. Adding an attribute
1. Use the Attribute wizard to specify the attribute.

2. After finishing the wizard a proper Value editor is invoked. Enter the value and press Enter.

3.6. Adding a value
1. Select the attribute where you would like to add a value.

2. Choose  New Value from tool bar or context menu or hit Strg-+. This invokes a proper Value editor

3. Enter the value and press Enter.

3.7. Modifying a value
1. Select the value you would like to edit.
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2. Invoke the default Value editor by pressing Enter or F7 or double-click the value.

or

Invoke a custom Value editor by choosing one from Edit Value With in the context menu.

3. Modify the value and press Enter.

3.8. Deleting attributes and values
To delete attributes and values select the attributes and values you would like to delete and choose 
Delete from tool bar or context menu or press Delete key.

3.9. Modifying the object class
To modify the object class please use the Edit Entry wizard.



119

Chapter IV. Reference
RFCs

RFC 4510: LDAP: Technical Specification Road Map  [rfc/rfc4510.txt]
RFC 4511: LDAP: The Protocol  [rfc/rfc4511.txt]
RFC 4512: LDAP: Directory Information Models  [rfc/rfc4512.txt]
RFC 4513: LDAP: Authentication Methods and Security Mechanisms  [rfc/rfc4513.txt]
RFC 4514: LDAP: String Representation of Distinguished Names  [rfc/rfc4514.txt]
RFC 4515: LDAP: String Representation of Search Filters  [rfc/rfc4515.txt]
RFC 4516: LDAP: Uniform Resource Locator  [rfc/rfc4516.txt]
RFC 4517: LDAP: Syntaxes and Matching Rules  [rfc/rfc4517.txt]
RFC 4518: LDAP: Internationalized String Preparation  [rfc/rfc4518.txt]
RFC 4519: LDAP: Schema for User Applications  [rfc/rfc4519.txt]
RFC 2849: The LDAP Data Interchange Format (LDIF) - Technical Specification  [rfc/rfc2849.txt]
RFC 3866: Language Tags and Ranges in the LDAP  [rfc/rfc3866.txt]

Obsolete RFCs
RFC 2251: Lightweight Directory Access Protocol (v3)  [rfc/rfc2251.txt]
RFC 2252: Attribute Syntax Definitions  [rfc/rfc2252.txt]
RFC 2253: UTF-8 String Representation of Distinguished Names  [rfc/rfc2253.txt]
RFC 2254: The String Representation of LDAP Search Filters  [rfc/rfc2254.txt]
RFC 2255: The LDAP URL Format  [rfc/rfc2255.txt]
RFC 2256: A Summary of the X.500(96) User Schema for use with LDAPv3  [rfc/rfc2256.txt]
RFC 2829: Authentication Methods for LDAP  [rfc/rfc2829.txt]
RFC 2830: Extension for Transport Layer Security  [rfc/rfc2830.txt]

Tutorials
JNDI Tutorial [http://java.sun.com/products/jndi/tutorial/]

rfc/rfc4510.txt
rfc/rfc4510.txt
rfc/rfc4511.txt
rfc/rfc4511.txt
rfc/rfc4512.txt
rfc/rfc4512.txt
rfc/rfc4513.txt
rfc/rfc4513.txt
rfc/rfc4514.txt
rfc/rfc4514.txt
rfc/rfc4515.txt
rfc/rfc4515.txt
rfc/rfc4516.txt
rfc/rfc4516.txt
rfc/rfc4517.txt
rfc/rfc4517.txt
rfc/rfc4518.txt
rfc/rfc4518.txt
rfc/rfc4519.txt
rfc/rfc4519.txt
rfc/rfc2849.txt
rfc/rfc2849.txt
rfc/rfc3866.txt
rfc/rfc3866.txt
rfc/rfc2251.txt
rfc/rfc2251.txt
rfc/rfc2252.txt
rfc/rfc2252.txt
rfc/rfc2253.txt
rfc/rfc2253.txt
rfc/rfc2254.txt
rfc/rfc2254.txt
rfc/rfc2255.txt
rfc/rfc2255.txt
rfc/rfc2256.txt
rfc/rfc2256.txt
rfc/rfc2829.txt
rfc/rfc2829.txt
rfc/rfc2830.txt
rfc/rfc2830.txt
http://java.sun.com/products/jndi/tutorial/
http://java.sun.com/products/jndi/tutorial/


120

Chapter V. Tips and tricks
TODO...


